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NOAA recently released this new Blue Marble image of Earth, created by combining multiple VIIRS images from the Suomi-NPP satellite.
Image: NASA/NOAA
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Many readers will be familiar with the Blue Marble visualisations of Earth created by NASA 
using MODIS imagery acquired from their Terra satellite. Recently, a new Blue Marble 

image was created from fi fteen passes of the new Suomi-NPP satellite on May 26, 2012. 
But there is a difference: this image looks down on Earth from above the North Pole. It’s so 
spectacular that it appears on this quarter’s cover. You can read more about this visualisation 
in ‘View from the Top’ on page 34. There have now been several follow-up Suomi Blue Marble 
images which van be viewed at

http://npp.gsfc.nasa.gov/science/feature2012-bluemarble.html

This issue sees us returning to the grass roots of satellite imaging with the second part of 
Ron Hahn’s series on APT Weather Satellite Reception.  This time, Ron focuses on the 

popular WXtoImg software package, and provides a detailed guide to its features, aimed most 
particularly towards newcomers to the hobby.

My immediate thoughts are that David Taylor has developed several new software packages 
in recent years: looking at his website I note CHLO Viewer, CMA Viewer, Metop LSA 

Viewer and MODIS L1 Viewer.

I presume that there are GEO members who use these software packages, yet nothing has 
ever been mentioned of them in the pages of GEO Quarterly.

It would be very much appreciated if readers familiar with these packages, and who are making 
use of them regularly, would be kind enough to write articles for GEO describing how to utilise 

them: a basic ‘how-to’ guide outlining the main features that they provide, and descriptions of the 
results that can be obtained. Little really new has happened in amateur Earth Imaging recently. 
This could be just the trigger needed to awaken enthusiasm and, perhaps, encourage seasoned 
GEO members to remain in the fold.

Les Hamilton
geoeditor@geo-web.org.uk

Masthead photograph: Morven in Aberdeenshire, seen from Tomnaverie recumbent stone circle.
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Francis Bell

MSG-3
My first comment must be to offer congratulations to EUMETSAT 
and ESA for the successful launch of MSG-3. I watched the launch 
live on TV and it was impressive, with such a massive rocket and 
the short time scale for the satellite to reach orbit. I know other 
manoeuvres are necessary to secure the final orbit but the first 30 
minutes were thrilling. I believe that the testing and commissioning 
of MSG-3 are progressing according to plan. Again: congratulations 
to all concerned.

Envi-Ham
On a less happy note, I understand that the Earth observation 
satellite ‘Envisat’ is effectively lost, which is a great disappointment 
to me. I just loved receiving those outstanding Earth images 
disseminated via the Envi-Ham programme. I don’t know what the 
future now holds, but I have written to the ‘Principal Investigator’, 
Stefano Badessi in Frascati, asking if there are alternative images/
data sources in mind for the Envi-Ham project. As soon as I receive 
a response I will try to inform GEO members. 

Membership Renewals
Elsewhere in this Quarterly you can read about our members’ AGM 
which took place in Guildford on June 8. In addition to the meeting 
there were further informal discussions which took place over the 
weekend and some of these resulted in a number of action points 
one of which related to membership renewal procedures.

subscriptions. For overseas members, and, indeed, UK members, 
the option remains of using PayPal. And when dealing with different 
currencies and making a sterling payment, this may remain the 
preferred option.

The Format of GEO Quarterly
It has been suggested on a number of occasions that 
GEO Quarterly be made available in electronic format as an 
alternative to the printed copy we currently enjoy. There are a 
number of ways this could be achieved and we will be guided 
by members’ opinions. Our membership secretary is currently 
canvassing opinion on this subject, and no decision will be taken 
until this is complete. My view is that I value the printed copy 
of GEO Quarterly and would not wish to see it substituted by 
an electronic version. I confirmed this to myself when I saw the 
electronic copy of EUMETSAT’s 25 year history in PDF format on 
their website. I viewed the web material diligently, but promptly 
requested a copy of the printed book which I find much more user 
friendly!

There are also issues to be addressed relating to printing costs, the 
number of copies we print, distribution and the security of material 
published electronically. Until we are all happy, the short term plan 
is continue with our printed Quarterly.

EUMETCast Receivers
We now hold fresh stocks of the DVBWorld EUMETCast receiver. 
Some months ago there was doubt over whether we could buy 
more stocks of this receiver but this is now resolved. We currently 
hold stocks that should satisfy demand for a few years to come. 
During this period of uncertainty, I bought two TechniSat ‘SkyStar’ 
receivers from Germany to test them for EUMETCast reception. 
Both the basic S1 and the S2 HDTV receivers worked well with 
EUMETCast reception and were compatible with the David Taylor 
software which I run at home. Should the day ever come when our 
DVBWorld receiver is not available, it’s reassuring to know that 
there are modestly priced alternatives available.

The popular DVBWorld receiver is shown here alongside the 
TechniSat USB 2 receiver (centre), now in service with GEO’s 
mobile EUMETCast receiving station. Note that the remote control 
unit is not needed for EUMETCast reception but is usful if watching 
the many TV stations available on the same satellite’s transponder.

Interestingly, EUMETSAT are testing one of ‘our’ DVBWorld 
receivers for compatibility with their potential new data formats, 
which I believe are 64-bit. There will never be an end to the 
evolution of data speeds and formats, so it’s reassuring to 
know that collaboration is taking place between some of our 
knowledgeable GEO members and EUMETSAT. I wish to record 
my thanks to both sides involved with these technical issues for 
keeping the GEO membership up-to-date with live EUMETCast 
reception.

The GEO party enjoying a meal together following the AGM held at SSTL

It is clear that GEO loses many members each year by the default 
of just not renewing their membership. I know from the responses 
I receive from the membership renewal reminders that I send out 
that only a small number say they actively decided not to renew 
because of changed interests or other equally valid reasons. Many 
others, I suspect just fail to renew by default.

In order to minimise this drainage of members, UK readers will, in 
future, be invited to complete a bank ‘Standing Order Mandate’. 
This has a double advantage. Firstly members will only have to 
complete one mandate and their annual renewal will be done 
automatically via the bank. However, this mandate or instruction 
can be cancelled by the member at any time. In return, GEO will 
try to keep the annual subscription constant for as long as possible 
hence minimising the need to alter bank mandates. Members will 
receive the necessary form when their next renewal becomes due. 
A second advantage is the saving GEO will make by not having 
to pay commission to PayPal or others when receiving members’ 
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Meteorological Technology World Expo 2012
Following last year’s inaugural event, 
Meteorological Technology World Expo 
2012 will take place in Brussels, Belgium 
on October 16-18 this year. Information 
indicates that there will be about 160 
exhibition stands and a full programme of 
lectures and presentations. Interestingly, 
there is free admission to this event for 
the general public. At the time of writing 
I’m not sure whether GEO will have 
a stand in the exhibition area but the 
opportunity to attend such an event free 
of charge seems too good to miss. For 
more details about this event, and for 
registration, visit

www.
MeteorologicalTechnologyWorldExpo.

com

Software Defined Radio
I have to admit I’m on a learning curve 
with software defined radio. I attended 
an evening presentation on the subject 
by David Simmons, and Arne van Belle 
briefly spoke about it during the recent 
GEO afternoon visit to SSTL in Guildford. 
However, I still consider myself a 
beginner on this subject. I would like to 
know where I can buy a receiver covering 
APT frequencies? Also, where can I 
obtain the necessary software to run such 
a system? 

I would love to hear from any reader 
experience in this area and willing to help 
me: and better still, I would very much 

appreciate it if someone could write an 
article on software defined radio for GEO 
Quarterly.

Space Link
I am currently progressing collaboration 
with this educational group which evolved 
out of my Millennium Satellite programme 
in the late 1990s. Space Link, who are 
supporting space topics in schools, visit 
different schools a number of times each 
term, and I am currently assembling a 
mobile EUMETCast station for them to 
demonstrate weather satellite reception 
in a school context. I would like to see 
as many schools as possible running 
daily live satellite reception, and GEO 
will certainly try to help where we can. To 
learn a little more about this educational 
project visit their web site at

www.spacelink.org
Space:UK
Quite by chance, I have just received the 
latest copy of the Space:UK magazine, a 
special edition celebrating 50 years of the 
UK in space. It is well worth reading. I did 
review this publication in GEO Quarterly 
34, page 40, but this is just a reminder 
that Space:UK is available free of charge. 
To be placed on the regular mailing list 
write to:

Newsletter and Space:UK Subscription,
UK Space Agency,
Polaris House,
North Star Avenue,
Swindon SN2 1SZ

Poster advertising the 2nd eteorological Technology World Expo

Continued on page 9

This Quarterly Question is very straight 
forward:

‘What was the mass of the recently 
orbited MSG-3 satellite, in kilograms, 

at the time of its launch?’

For my reference, I have a definative 
answer from EUMETSAT which I will 

use to judge answers. Please send your 
answers to Francis Bell at

francis@geo-web.uk

by October 31, 2012. 

A winner, picked from the correct 
answers submitted to me,, will 
receive a new copy of the book 
EUMETSAT 25 Years, reviewed on 
page 40 of this issue. Help can be found 
on the web, either at ESA or EUMETSAT.
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Les Hamilton

When the European Space Agency’s Envisat lifted off from the 
Kourou Space Centre in Guyana on March 1, 2002, the 8.2 tonne 
craft became the largest civilian Earth observation satellite ever 
to enter orbit. By comparison, NASA’s Terra satellite weighs in 
at a mere 5.2 tonnes. And with a minimum design lifetime of five 
years, Envisat had continued to transmit flawlessly beyond its 
tenth anniversary until all contact mysteriously ceased on April 8 
this year. Envisat’s final two images were received shortly after 
11:00 UT on that date, a MERIS image of the Iberian peninsula 
(figure 1) and an Advanced Synthetic Aperture Radar (ASAR) 
image showing the Azores (figure 2).

Envisat’s abrupt failure came as a real surprise: there had been 
no hint of any problem—such as image degradation—prior to loss 
of contact. Readers will no doubt recall how several of the NOAA 
weather satellites (NOAAs -12, -14 and -17 in particular) exhibited 
fluctuating imagery problems during the years and months prior to 
their ultimate failures.

The reason for Envisat’s sudden demise remains unknown, but 
could result from a number of causes. Initially, ESA expressed the 
hope that a fault with the satellite’s electronics might have placed 
Envisat into ‘safe mode’, from which recovery should have been 
routine. However, despite tireless efforts throughout April, when 
continuous commands were sent to Envisat via a widespread 
network of ground stations, the craft obstinately refused to respond. 

Another possibility was that a piece of space junk might have 
damaged Envisat’s 70 m2 solar array, thus depriving the satellite 
of power or destabilised its orbit. But images from, the French 
Space Agency’s new Pleiades satellite [3]—which normally provides 
very high-resolution 
images of Earth but 
which was reoriented 
towards Envisat on 
April 15—indicated that 
it was still intact, and 
optical, radar and laser 
observations from the 
ground confirmed that 
Envisat remained in a 
stable orbit. Another 
possible scenario was 
that a power regulator 
might have failed, 
blocking telemetry and 
telecommands to and 
from Envisat.

In early May, after a month-long recovery effort proved fruitless and 
the cause of the failure remained unsolved, ESA formally declared 
the end of the Envisat mission. But ESA have not completely lost 
hope and will continue making attempts to re-establish contact with 
their flagship satellite for some months yet.

References
1 Advanced Synthetic Aperture Radar from Envisat - GEOQ 1, page 22
2 Multitemporal ASAR Imagery from Envisat - GEOQ 21, page 36
3 Pleiades - http://smsc.cnes.fr/PLEIADES/

Figure 1
Envisat’s Medium Resolution Imaging Spectrometer (MERIS) captured this 
image at 11:05 UT on 8 April 2012. The image shows Portugal and Spain and 
was the last data transmitted via Ka-band before communication was lost.

Image: ESA

Figure 2
This ASAR image, transmitted at 11:09 UT on 8 April 2012, shows Spain’s 

Canary Islands, and is the final Envisat data transmitted via X-band.
Image: ESA

This image of Envisat was acquired by the 
Pleiades Earth Observation Satellite, and shows 
Envisat at a range of about 100 kilometres. 
Envisat’s main body, solar panel and radar 
antenna are all clearly visible.

Image: CNES
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I have previously reported my contacts with the Amberley Museum 
and Heritage Centre and can now report on the successful 
completion of a small project which will, I hope, provide the general 
public and many school groups with access to live EUMETCast 
images.

The Amberley Museum site is set in the heart of the South Downs 
National Park and located in a disused chalk quarry. In the past, the 
chalk was excavated for burning into lime which was then used for 
agricultural applications over the Weald of Kent. Lime production 
ceased many years ago and the quarry site became more or 
less abandoned. More recently, the 36 acre site has become 
home to a unique collection of listed buildings and scheduled 
ancient monuments, many from the Sussex area of the UK. The 
museum and exhibition buildings, about 40 of them, cover not 
only the history of the site, but incorporate country crafts, railways, 
electricity generation and distribution, the history of telephone 
communications and a dedicated building covering the history of 
radio communications. The radio building also houses an amateur 
radio station run by Amberley Museum Amateur Radio Club 
GB2CPM (Chalk Pit Museum).

I have visited this heritage site several times but was prompted 
by Paul Le Feurve G0DBS, a member of my own Three Counties 
Amateur Radio Club, who had also spoken to the people running 
the amateur radio station at the Amberley museum site. He told 
me that they had expressed an interest in establishing a weather 
satellite receiving station and to have this running whenever they 
were manning their amateur radio station. With this background in 
mind I visited the museum again, and discussed with the radio club 
members there the hardware and software necessary to run a live 
EUMETCast station in the Radio and Communications building.

Francis Bell

10°E, which carries the EUMETCast data stream: hence a decision 
was made to progress this project. From my perspective, the 
inducement was to have a EUMETCast station available to the 
visiting public and particularly to school groups. However, there was 
little money available, so GEO called on the goodwill of some of 
its own members to provide the necessary hardware and software. 
Eventually, after a number of tests, and moving equipment from 
one location to another, a working station was established. The 
contributors to the station were:

• Amberley Radio Club, who provided the dish which was 
securely located on a mast and gave a strong signal.

• David Simmons G1MAL, who provided the computer. 
• GEO, who sponsored the purchase, at a reduced rate, of 

software from David Taylor GM8ARV.
• The EKU, was provided by David Stickland, an ex GEO 

member.
• EUMETSAT, who made the necessary configuration changes 

to enable the EKU to access data streams.

David Taylor and I recently revisited the site and checked that 
everything continued to work. We were greeted by a working 
system, but with a display which was in need of some adjustments. 
David made changes to the software to improve the display and 
make the system easier to use. Because the station is manned 
by different members of the Amberley’s Radio Club, the weather 
satellite station was made as easy to operate as possible. For the 
future, I would like to see their EUMETCast display monitor in a 
more prominent position: this was discussed by the Amberley Radio 
Club for possible action in the near future.

I am very pleased with the outcome of this small project, the prime 
motivation having been to make EUMETCast images available for 
viewing by the general public, particularly school groups. My thanks 
to all who have contributed to this project.

If you have the time, and are in the area of the Amberly Museum 
and Heritage site, it’s well worth a visit. You could easily spend 
a whole day there. For more details, and information about other 
events held there, visit their web site at

www.amberleymuseum.org.uk

David Taylor (GEO ) and Sandra Grindlay G0KAG (Amberley Radio Club ) 
pictured with amateur radio equipment and the live EUMETCast display.

One issue that immediately came to mind was the site’s view of the 
sky. Being in a disused quarry with adjacent cliffs, I questioned if 
direct satellite reception would be possible. To resolve this issue, 
I returned a few days later with my mobile station which I set up 
just outside the Radio and Communications building. Good news: 
there was an excellent signal from EUMETSAT’s relay satellite at 

Francis Bell G7CND successfully established a EUMETCast station on the 
steps of the Amberley Museum’s Radio and Communication Building.
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The unexpected failure of Envisat earlier this year (see page 4) has 
left ESA with a major problem. Unlike other satellite programs such 
the NOAA and Metop series, there is no Envisat-2: none was ever 
planned. Perhaps the very longevity of Envisat, where the satellite’s 
mission was successfully extended beyond twice its design lifetime, 
may have induced a degree of complacency regarding its eventual 
replacement. Work had, of course, been progressing on Envisat’s 
eventual replacement, the Sentinel missions, for a number of years, 
but the earliest launch is not scheduled before mid 2013.

Les Hamilton

robust data sets for GMES Services. The first Sentinel-1 satellite 
is expected to be launched during 2013, to be followed by its twin 
in early 2015. Sentinel-1 will ensure the continuity of C-band SAR 
data, building on heritage SAR systems established by ESA and 
Canada with ERS-1, ERS-2, Envisat and Radarsat. 

The Sentinel-1 pair is expected to provide coverage over Europe, 
Canada and major shipping routes over a 1–3 day period, 
regardless of weather conditions. Radar data will be delivered 
to end users within an hour of acquisition, a big improvement 
over current SAR systems. Sentinel-1 is being realised by an 
industrial consortium led by Thales Alenia Space (Italy) as prime 
contractor and Astrium (Germany) who are responsible for the 
C-SAR payload, which will incorporates a central radar electronics 
subsystem developed by Astrium UK. Sentinel-1 will be launched 
on a Soyuz rocket from Europe’s Spaceport in French Guiana. 

Sentinel-2
Sentinel-2, the optical mission segment of the GMES programme, 
is also a twin satellite system. From 2013 onwards, the first satellite 
will circle the Earth in a sun-synchronous polar orbit, fully covering 
the planet’s landmasses every ten days. When the second satellite 
of the constellation follows it into orbit in 2015, this interval will be 
reduced to just five days.

ESA is in fact developing five new missions under the Sentinel 
umbrella; some of these are satellites in their own right but others 
simply packages that will share platforms with future Meteosat 
Third Generation and Metop satellites. The ESA Sentinels will 
become the first operational satellites to meet the Earth observation 
needs of the European Union-ESA GMES (Global Monitoring for 
Environment and Security) programme.

 http://www.gmes.info/

The instrumentation that flew aboard Envisat will no longer be 
carried by a single satellite, and the operations will be shared 
between the Sentinel missions as follows:

Sentinel-1  SAR imaging
Sentinel-2 High resolution optical imaging
Sentinel-3 Low resolution optical imaging + Altimetry
Sentinel-4 Atmospheric Monitoring from geostationary orbit
Sentinel-5 Atmospheric Monitoring from low Earth orbit

Sentinel-1
The Sentinel-1 mission, the European Radar Observatory, will 
consist of a constellation of two polar orbiting satellites devoted to 
Synthetic Aperture Radar (SAR) applications. These satellites will 
follow sun-synchronous orbits at an altitude of 693 kilometres with a 
12-day repeat cycle. Sentinel-1 is a C-band radar imaging mission 
aimed at providing continuity for ERS and Envisat data products to 
be used for operational services. The mission will benefit numerous 
services, particularly those relating to

• the monitoring of Arctic sea ice extent, including routine sea 
ice mapping,

• surveillance of the marine environment, including oil-spill 
monitoring and ship detection for maritime security,

• monitoring land-surface for motion risks,
• mapping for forest, water and soil management,
• mapping to support humanitarian aid and crisis situations. 

Sentinel-1
Image: P Carril - ESA

The C-band radar is unhindered by cloud and will make continuous 
all-weather imagery possible by day and night, while the twin 
satellites will fulfil revist and coverage requirements to provide 

Sentinel-2
Image: Astrium GmbH

Sentinel-2 will carry the multispectral instrument (MSI), which will 
generate wide-swath, high-resolution optical images in 13 spectral 
channels in both the visible and short-wave infrared ranges, with 
a swath width of 290 km. Sentinel-2 is intended to image Earth’s 
landmasses from its 800 km sun-synchronous polar orbit for at least 
7 years, thus securing continuity of optical Earth observation as a 
successor to the Spot and Landsat satellites currently in operation. 
This will provide a lasting supply of comprehensive data that will 
serve as a basis for operational services in:
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• land monitoring, providing imagery of vegetation, soil and 
water cover, inland waterways and coastal areas,

• land cover, usage and change-detection-maps
• creating geophysical variable maps (such as: leaf chlorophyll 

content, leaf water content, leaf area index)
• forestry,
• fast imaging for disaster control and humanitarian relief 

programmes.
Sentinel-2 will also be able to observe natural disasters such as 
floods, volcanic eruptions, subsidence and landslips.

Sentinel-3
The main objectives of the Sentinel-3 spacecraft are the 
measurement of sea-surface topography, sea- and land-surface 
temperature and colour with high-end accuracy and reliability in 
support of ocean forecasting systems, and for environmental and 
climate monitoring. The mission will also provide measurements 
of elements of atmospheric chemistry at high temporal and spatial 
resolution. The Sentinel-3 instrumentation includes:

• A Sea and Land Surface Temperature Radiometer (SLSTR) 
based on Envisat’s Advanced Along Track Scanning 
Radiometer (AATSR). This will determine global sea-surface 
temperatures to an accuracy of better than 0.3°C. The SLSTR 
improves the along-track-scanning dual-view technique of 
AATSR and provides advanced atmospheric correction. 
SLSTR measures in nine spectral channels and two additional 
bands which are optimised for fire monitoring. The SLSTR 
has a spatial resolution in the visible and shortwave infrared 
channels of 500 m, and 1 km in the thermal infrared channels.

• An Ocean and Land Colour Instrument (OLCI) based 
on heritage from Envisat’s Medium Resolution Imaging 
Spectrometer (MERIS). With 21 bands, compared with the 
15 of MERIS, the design has been optimised to minimise sun-
glint and provide a resolution of 300 metres over all surfaces. 
OLCI marks a new generation of measurements over the 
ocean and land. 

• A dual-frequency (Ku and C band) advanced Synthetic 
Aperture Radar Altimeter (SRAL) based on CryoSat heritage, 
which will provide along-track measurements at a resolution of 
approximately 300 metres in SAR mode. SRAL is supported 
by a microwave radiometer for atmospheric correction and a 
DORIS receiver for orbit positioning. 

Near-realtime data will be provided for ocean forecasting, sea-ice 
charting, and maritime safety services—who require accurate and 
timely measurements of the state of the ocean surface, including 
surface temperature, ocean ecosystems, water quality and pollution 
monitoring. 

Land services—to monitor land-use change, forest cover, 
photosynthetic activity, soil quality and fire detection—will also 
benefit significantly from Sentinel-3.

Sentinel-4 is a payload that will be flown on a Meteosat Third 
Generation-Sounder (MTG-S) satellite in geostationary orbit, 
provisionally scheduled for launch in 2019. Sentinel-4 is dedicated 
to atmospheric monitoring and covers the needs for continuous 
measurement of the atmosphere’s chemistry at high temporal and 
spatial resolution from geostationary orbit. The main data products 
will relate to O3, NO2, SO2, formaldehyde (HCHO) and aerosol 
optical depth. These will be generated hourly to support air quality 
monitoring and forecast over Europe.

Sentinel-4’s UVN instrument is a high resolution spectrometer 
covering the ultraviolet (305-400 nm), visible (400-500 nm) and 
near-infrared (750-775 nm) bands. The spatial sampling is 8 km 
at a spectral resolution ranging between 0.12 nm and 0.5 nm 
(depending on the band).

Sentinel-5 is a payload that will be flown aboard a Metop Second 
Generation satellite, likely to be launched in 2020. Dedicated to 
atmospheric monitoring, Sentinel-5 will increase the frequency 
of cloud-free observations required for the study of tropospheric 
variability. 

Five years prior to this, a Sentinel-5 Precursor mission is expected 
to launch on an Astrobus L 250M space platform from Astrium to 
provide measurements of ozone, NO2, SO2, CO and aerosols. This 
mission is designed to bridge the inevitable gap between NASA’s 
current EOS Aura Mission and Sentinel-5. The precursor payload 
is a UV-VIS-NIR-SWIR spectrometer derived through tailoring 
the Sentinel-5 specifications to give priority to spectral resolution, 
coverage, spatial sampling distance, signal-to-noise ratio and only 
high priority bands.

Acknowledgements and Further Reading
Thanks to ESA, Astrium and USGS for making the following 
illustrated documents available. These proved invaluable in 
compiling this article, and contain a wealth of further information.

Overview of the Sentinel Programme
http://landsat.usgs.gov/documents/10_Martimort_Sentinel2.pdf

Astrium Sentinel Datasheets
http://www.astrium.eads.net/media/document/sentinel_data_sheet_1.pdf
http://www.astrium.eads.net/media/document/sentinel_2_data_sheet.pdf

ESA Sentinel Datasheets
http://esamultimedia.esa.int/docs/S1-Data_Sheet.pdf
http://esamultimedia.esa.int/docs/S2-Data_Sheet.pdf
http://esamultimedia.esa.int/docs/S3-Data_Sheet.pdf
http://esamultimedia.esa.int/docs/S4-Data_Sheet.pdf
http://esamultimedia.esa.int/docs/S5-prec_Data_Sheet.pdf

Sentinel-3
Image: J Huart - ESA

The combined topography package will provide exact 
measurements of sea-surface height, essential for ocean 
forecasting systems and climate monitoring. SRAL will also provide 
accurate topography measurements over sea ice, ice sheets, rivers 
and lakes.

The first Sentinel-3 satellite is expected to launch into its 815 km 
sun-synchronous orbit in 2013, eventually to be followed by its twin. 
The Sentinel-3 duo will enable a short revisit time of less than two 
days for OLCI and less than one day for SLSTR at the equator. The 
satellite orbit provides a 27-day repeat for the topography package. 

MSG-3 Launch
The latest weather satellite in Europe’s highly successful Meteosat 
second-generation series was successfully orbited by an Ariane 5 
rocket on July 5. The launch took place from Europe’s Guiana 
Space Centre in Kourou in French Guiana.

MSG-3 is the third in a series of four satellites which carry the 
SEVIRI imager, which focuses on Europe and Africa to deliver 
weather coverage, scanning Earth’s surface and atmosphere every 
15 minutes in 12 different wavelengths.

It is planned to launch MSG-4 in 2015



 GEO Quarterly No 35 The Group for Earth Observation September 2012

8 www.geo-web.org.uk

SSTL’s roots hark back to the days of the 
amateur radio satellites built and operated 
by Surrey University. In those early 
‘Operational Satellite Carrying Amateur 
Radio’ (OSCAR) days, both the technology 
of operating in space and the format of the 
radio signals were in an experimentally 
stage. In the late 1970s, the orbiting 
OSCAR 8 satellite ran into unexpected 
problems and it was the expertise of 
Surrey University’s amateur radio group 
which led to this satellite being rescued. 
Shortly afterwards, at short notice, NASA 
recognised Surrey’s achievement and 
offered to launch one of their satellites 
as a secondary payload on the launch of 
the Solar Mesosphere Explorer satellite in 
October, 1981. 

The University responded by designing and 
building a small amateur radio satellite, 
74 × 42 × 42 cm, within the six months 
deadline they were given. University 
of Surrey Satellite 1 (UoSAT 1), also 
designated OSCAR 9, proved a great 
success and operated in space for exactly 
eight years before its re-entry. UoSAT 1 
was followed by UoSAT 2 (OSCAR 11) in 
1982. Although well beyond its operational 
design life, signals from this satellite can 
still be detected today. It was in fact my 
personal involvement with the UoSATs and 
their Packet Radio facilities which ‘launched’ 
my lifetime interests in Earth observation 
satellites.

These successes built upon the skills 
and experiences learned at Surrey 
University led to the department becoming 
a commercial business, constructing and 
operating satellites for others. No longer 
a mere department within the university, 
a commercial company, Surrey Satellite 
Technology Limited (SSTL) was born. The 
facilities necessary to support this rapidly 
expanding venture demanded a new 
building next to the university’s existing 
electrical engineering department, and this 
came to fruition in the 1990s. 

Within a mile of Surrey University’s campus 
is a research park where a number of high 
technology businesses are located. The 
logical expansion of SSTL has resulted 
in new facilities, consisting of a satellite 

The afternoon of July 8, 2012 was certainly 
a date to be remembered, both from the 
perspective of meeting GEO friends and for 
visiting the UK’s latest satellite assembly 
facility, owned and run by Surrey Satellite 
Technology Limited (SSTL), a leading 
UK company in the satellite and Earth 
observation arena.

Francis Bell

The SSTL satellite assembly building
Photo: David Taylor

The GEO visitors pictured outside the SSTL satellite assembly building
Photo: Baz Omidi

Arne van Belle making his presentation
on software defined radio

Photo: David Taylor

A chance meeting of old friends, Francis Bell (left) and 
Professor Craig Underwood of Surrey University

Poto: Arne van Belle
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assembly building with a separate office and administration building, being built 
in this research park rather than expanding over the university campus. This new 
assembly building was officially opened last year, and must be the most advanced 
satellite assembly building in the UK: it was this facility which we had come to see.

The Visit
SSTL were very flexible and hospitable with our visit, which was split between their 
large meeting room and a tour of the adjacent satellite assembly building. There 
were twelve GEO members present which, for a weekday afternoon visit, was 
close to what had been expected. 

Our afternoon commenced at 1.30 pm, in the meeting room, when we enjoyed a 
presentation relating to radio receivers and software defined radio from Arne van 
Belle of the Dutch Werkgroep Kunstmanen. Personally, I was on a sharp learning 
curve with this subject area as I have never used software define radio, but I have 
subsequently attended a lecture on the subject. Familiarising myself with this 
subject is a personal project for the coming year. I did not fully understand all Arne 
presented to us but his message seemed to be that the future of radio reception 
will become ever more reliant on sophisticated software rather than hardware.

Next came a 30-minute illustrated talk from Ian Stotesbury of SSTL, detailing the 
company’s history and business rationale. He also presented examples of SSTL’s 
current and past satellite programmes, and we were all impressed by the quality 
of imagery produced by SSTL’s satellites. I asked if it were possible to receive 
such images directly at home but was gently reminded that these are commercial 
images and, unless published by SSTL, they are not generally accessible to user 
groups such as GEO.

GEO members who are interested in SSTL are strongly advised to visit their 
website, which comprehensively covers all aspect of their business and also 
reflects the close ties which still exist between SSTL and Surrey University.

www.sstl.co.uk

An illustrated summary of Ian Stotesbury’s talk appears on page 26.

The Assembly Building Tour
Although I had no particular expectation of the Satellite Assembly building, this 
did not prevent me from being surprised by the scale of the main assembly room. 
The two-story frontage of the building consisted of distinct rooms where we 
saw component modules for satellites being assembled by hand. We could not 
enter these ‘clean’ rooms because of the potential contamination we might have 
introduced. However, large windows allowed us to view the activities within each 
room. Throughout the tour, guides Ian Stotesbury and Jordi Barrera-Aars explained 
which satellite modules were being constructed and tested.

From the viewing area on the second level, the main assembly hall could be seen 
stretching from one end of the building to the other, three stories tall and filled with 
satellites under construction. A photograph of the hall can be seen on page 26. On 
enquiring why such a high and spacious hall was needed, our guides explained 
that this was needed not only for construction but also for manoeuvring fully built 
satellites. For example, a three metre tall satellite would need to be lifted vertically 
to place it into a container, which could require headroom of up to six metres. 
Additional space for manoeuvring and room for lifting equipment in the roof results 
in a very tall assembly hall. At the time of our visit some six or eight satellites 
were under construction, some of them Galileo satellites for the European Uniln’s 
satellite navigation programme. Security meant that we could not take photographs 
inside the assembly building but there are some photographs on SSTL’s web site 
at

www.sstl.co.uk/media-gallery/images

showing the inside of the assembly building and some example satellite images. 
SSTL have made an archive of some fifty of their images and photographs 
available for download at

https://dl.dropbox.com/u/84436143/SSTL%20Gallery.zip

Back in the meeting room I thanked Ian and Jordi for their time, their skilful 
presentation and for the fascinating tour of their assembly building.

GEO Group Photo
Those pictured in the group photograph opposite are, left to right:

Arne van Belle, Donald Martin, David Taylor, John Green, Baz Omidi, Francis 
Bream, Vaughan Cherry, John Tellick, Francis Bell, David Bland, Paul le Feurve, 
David Anderson.

Future Events

September 28-29, 2012
The RSGB and Lincoln Short Wave Club are 
hosting the National HamFest on the Newark 
showground. This is a large two-day event and 
GEO will be present on both days with a stand 
demonstrating live weather satellite reception. For 
more details go to

www.nationalhamfest.org.uk

October 16-18, 2012
The second Meteorological Technology World 
Expo in Brussels, Belgium. Entry is free if you 
preregister. For more details see

www.MeterologicalTechnologyWorldExpo.com

November 11, 2012
The busy West London Radio and Electronic 
Show takes place at Kempton. GEO will have 
a stand demonstrating live weather satellite 
reception. GEO will also be giving a public 
presentation on the subject of amateur reception 
of Earth observation and weather satellites. For 
more details go to

www.radiofairs.co.uk

Continued from page 3

Tornadoes hit Poland

On July 15, a wave of unusually powerful 
tornadoes ripped through northern Poland, 
wrecking houses, uprooting trees and downing 
power lines. Ten people were injured and thee 
was a single fatality, a 60-year-old man who 
was crushed to death when his summer cottage 
collapsed.

Some 1,200 rescuers worked to remove fallen 
trees, unblock roads and restore utilities in the 
hardest hit Baltic region of Pomerania.

There was a miraculous survival by a family of 
three when their caravan was sent flying through 
the air with them still inside it. Although the 
caravan smashed into pieces upon landing, none 
of its occupants suffered serious injury.
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Like all other members of the Envi-Ham project I was desperately 
disappointed with the loss of Envisat’s downlink signals in early 
April 2012. Reports about the loss of the satellite will have 
appeared elsewhere so I will not dwell on the details here. 
However, there was a tiny mitigation in the disappointment 
because, instead of the fresh daily satellite images, the Envi-Ham 
project did continue—by sending previously unreleased archived 
Envisat images until May 1, when the project closed. During these 
three weeks it was not known whether Envisat could be recovered 
but it gave a buffer at least to keep part of the programme running. 

During this period, I received two images which attracted my 
attention. One showed the Gulf of Oman and a dust storm being 
blown over the sea; the other was of southern Spain, showing the 
coastal areas adjacent to the Atlantic Ocean and the Mediterranean 
Sea which, I thought, showed the presence of marine algal blooms.

I speculated that the two processes—dust being blown over the 
sea and marine algal blooms—might be related. In order for algal 
growth to take place via photosynthesis, not only must there be 
light, water and carbon dioxide present but also other minerals, 
albeit in trace amounts. If these minerals are not present, there will 
be no algal growth no matter how favourable other factors may be. I 

felt that dust blown over the sea and then washed out by rain might 
be like adding a marine fertiliser, hence stimulating algal growth. 
The terrestrial analogy here would be a farmer adding fertiliser to a 
crop to stimulate its growth.

As a slight digression here I may mention that the UK sometimes 
experiences Saharan dust. This can be readily recognised by bright 
red dust deposited on light coloured cars and other light surfaces. 
This dust is transported by the same air stream which occasionally 
brings locusts to the UK: although not necessarily at the same time 
as the dust.

As an undergraduate at university, I spent one of my years 
studying oceanography. In those days, a branch of the UK National 
Oceanographic Centre was located just few miles from home. I took 
advantage of this and not only progressed my academic studies 
but, on a number of occasions, was able to visit the land-based 
research facilities of our National Centre with its practical studies.

Unfortunately, the Centre has been relocated from my area of 
Surrey to Southampton where it is co-located with Southampton 
University. However, to progress my interest in the two Envisat 
images I had received, I contacted the Centre and asked about 

Francis Bell

This false colour Envisat image, originally acquired at 07:10 UT on August 29, 2010, shows dust being blown over the Gulf of Oman.
Image: ESA
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any connections between dust storms over the sea and algal 
blooms. As a result of my enquiries I was contacted by Jason 
Hopkins, a PhD research student at the Centre who is researching 
the dynamics of marine phytoplankton production. As a result of 
our discussions, Jason agreed to write the article that appears on 
page 31 of this issue. Jason wrote:

 ‘I would be happy to write something about my PhD thesis 
which is looking at the dynamics of phytoplankton called 
coccolithophores. These form highly reflective patches across 
large areas of the ocean that can only be viewed by satellite and 
create some quite beautiful true colour images.

‘Your images certainly look interesting. There is a variety of 
literature that appears to show a connection between iron 
input to the surface ocean (perhaps from aeolian dust) and 
phytoplankton blooms in certain areas of the global ocean. It’s 
difficult to confirm whether the variation in ocean colour in the 

image at the top of this page is indeed an algal bloom without 
some type of sea truthing, or looking at the chlorophyll product 
from the same time-frame—as we often see a variation in ocean 
colour around the coasts from coloured dissolved organic matter 
which can be mistaken for a bloom in ‘true’ colour images.’

For readers who have issue No 2 of GEO Quarterly, you can 
find an article (pages 25 - 28) that I wrote which touches on 
marine phytoplankton production and its role in the carbon 
cycle. The article is illustrated by some electron micrographs of 
coccolithophores and foraminifera which are small marine algal 
cells.

Footnote
If, like the author, you are now the proud owner of a defunct 
Envi-Ham dish, there is a happier note. With just half a degree of 
rotation, these dishs can deliver a massive EUMETCast signal: so 
they have a future.

This Envisat image dating from 10:33 UT on November 2, 2010 shows southern Spain and Gibraltar
with what appears to be an algal bloom off Spain’s Atlantic coastline.

Image: ESA

A sad sight, Francis Bell’s Envi-Ham
dish put out to grass.

While the June 6 transit of Venus across the face of the sun was 
obscured by cloud across almost the entire UK, Fred van den 
Bosch, now living in Vietnam, was more fortunate.

Fred used a 25-inch Newtonian telescope with a Hyperion zoom 
lens. A layer of Baader sunfoil placed over the end of the tube 
made it safe to view the sun directly. Fred takes up the story:

“Here sunrise was 5:17, but it was cloudy. Around 6:30 the sun 
appeared behind the clouds and I was able to make the first 
photo. The second was made around 9:15 and shortly after that 
it completely clouded over. “I made the photos with my iPhone 
by holding it close to the eyepiece. A lot of trial and error was 
involved because even slight movement of the iPhone—as 
when pressing the shutter—tended to throw the image off-
screen; so I took lots of photos, and just a few turned out more 
or less OK.

“Back in Holland, the weather was very bad. Just a few people 
in the very north of Groningen saw a bit of the transit. Eight die-
hards drove more than 500 kilometres overnight to Travemunde 
on Germany’s Baltic coast, where they were rewarded with 
great views.”

Fred van den Bosch
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Most GEO members will know that 
the Head Quarters of EUMETSAT 
are located in Darmstadt, Germany. 
The HQ building accommodates 
administration and satellite operations 
together with data services and storage. 
However, the main radio dishes—which 
are in direct communication with 
EUMETSAT’s geostationary satellites—
are located at Usingen, about 50 km 
away.

EUMETSAT HQ
In the early days of European weather 
satellite operations, the administration 
was based within the European 
Space Operations Centre (ESOC) 
in Darmstadt. Back in the 1980s, 
with the success and growth of their 
weather satellite undertakings, it was 
determined that EUMETSAT needed 
their own purpose-designed building: 
accordingly, their new headquarters 
were built just 2 kilometres from ESOC 
in Darmstadt, and EUMETSAT staff 
occupied their new premises in 1994. 
Since the opening of their new HQ, 
EUMETSAT has continued to expand, 
and a large new technical operations 
centre built adjacent to their HQ, was 
opened in May 2012. It will be fully 
commissioned in due course. Even 
with their new building, the HQ is 
still located on a crowded Darmstadt 
site with restricted space for massive 
satellite dishes. Consequently, the 
ground station for linking directly with 
their satellites remains in Usingen.

Usingen
Usingen, located about 30 km north of 
Frankfurt, is an ancient town with a 
history going back at least 1500 years. 
Some of the town’s medieval buildings 
are to be found in its picturesque 
centre but the satellite communications 
facility, with its associated collection 
of very large dishes, is located about 
2 km farther west. This satellite site 
occupies an old WW2 airfi eld with no 
urban or industrial buildings nearby, 
at an altitude of about 400 metres, 
thus giving a good all-round view of the 
sky. The area has stable geology and 
provides plenty of room for deploying 
several hundred satellite dishes.

The site is run by Media Broadcast 
GmbH which, I believe, is a subsidiary 
of T-Systems who are based in 
Frankfurt.

I have visited the Usingen site twice, 
in 2007 and 2011, on each occasion 

with a visiting GEO party. During our 
2011 visit, we were given VIP treatment 
by our hosts, Media Broadcast. I did 
gently ask them if all visitors were given 
such treatment and was fl attered to be 
told that, because we were EUMETSAT 
guests, we were special, hence the red 
carpet treatment. My thanks at this 
point to Harriet Locke of EUMETSAT 
who organised the visit for us, and to 
Media Broadcast for allowing us access 
to their high-technology and security-
sensitive site.

Our visit in 2011 lasted a full morning, 
during which we were given a 
presentation by three Media Broadcast 
staff followed by a comprehensive tour 
of the site. I’m not sure how many 
satellites, with their multitude of 
transponders, were being controlled 
from this site, but I suspect that many 
satellites and hundreds, perhaps 
thousands, of TV and data channels 
were being processed. During our tour 
we visited the two giant EUMETSAT 
dishes and their control room, located 
in a small building at the bottom of 
one of the dishes. From their size 

it’s tempting to think these dishes 
remain in a fi xed position but, as I was 
standing next to one dish, it moved 
several times on its circular rails. I 
hadn’t quite realised how accurately 
these so called geostationary satellites 
are continuously tracked. 

The EUMETSAT dishes and their control 
equipment had a small number of staff 
on duty while we were visiting, but I 
understand that the operations can be 
controlled remotely from Darmstadt and 
perhaps elsewhere. The site tour was so 
interesting, with much to see, we could 
have spent more time there. But we had 
to depart for a pressing engagement 
in Darmstadt for a scheduled visit to 
the European Space Operations Centre 
(ESOC), so we had to thank our hosts 
and leave with just time enough to 
make it to ESOC. In the back of my 
mind I was so pleased to have seen 
for myself the ground station which 
handles all the EUMETCast data I 
receive at home on a daily basis.

Later I asked EUMETSAT to briefl y 
comment on their communication links 
with Usingen. This is the response I 
received from one of their technical 
staff.

“The Primary Ground Station 
supporting the Meteosat Second 
Generation(MSG) satellites is in 
Usingen, Germany, about 30 km 
north of Frankfurt. This ground 
station is the main channel of 
communications between the Mission 
Control Centre (MCC) and the 
Meteosat Second Generation (MSG) 
satellites. 

“The ground station at Usingen 
is usually unmanned and can be 
remotely monitored and controlled 
from the MCC in Darmstadt.

“The prime transmission channel 
between the MCC and the Primary 
Ground Station (PGS) is a 34 Mbit 
microwave link with a terrestrial-
based back-up link. These links 
support all traffi c to and from 
the PGS, including image data; 
Telemetry, Tracking and Command 
(TT&C), and disseminated data. 
To reliably accomplish these vital 
tasks a considerable amount of 
redundancy is incorporated in the 
station design, hence its ability to 
function completely automatically 
most of the time.”

Francis Bell

This radio tower provides microwave links
between the ground station and MCC in Darmstadt
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EUMETSAT’s near circular HQ building In Darmstadt can
be seen near the centre of this aerial photograph. 

Image: GoogleEarth

This aerial photograph shows the Usingen satellite dishes, with the
white, square-shaped operations building in the centre of the view.

Image: GoogleEarth

The old mediaeval centre of Usingen, viewed from a coach window. The visiting GEO party inside Media Broadcast’s visitor centre.

One of the EUMETSAT dishes 
with its control room at the base.

Outside the Visitor Centre. A collection of small dishes on the
roof of the operations building.

A group photo of the visiting GEO party.
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GEO paid it’s twelfth visit to the West London Radio and 
Electronics Show at Kempton last April which, with the 
exception of the annual National Radio HamFest at the 
Newark showground, must be one of the best attended rallies 
which overlaps with the interest areas of GEO members. Our 
stand was well place in the exhibition area, in a location more 
or less dictated by our needs to access mains electricity and 
feed coax to our stand to support live satellite reception.

We ran live EUMETCast signals on one computer and 
displayed slide shows of Envisat and APT images on two 
laptops. You have to be well organised to set all this up in 
about an hour. Securing the position and direction of the 
dish on the roof is critical for signal acquisition, and David 
Simmons aligned our 60 cm dish with the aid of his signal 
meter.

The day was busy with visitors to our GEO stand, all showing 
a genuine interest in our display. Some GEO memberships 
were renewed and several new members joined on the day. 
Interestingly, it has been reported back to me that there is a 
small but encouraging peak of new membership applications 
following these shows, so the time and effort devoted to 
establishing and manning a stand may be judged worthwhile 
from this perspective. However, it must be recognised that 

to our equipment, the problem disappeared. I suspect that 
continued handling of the original lead had resulted in its 
damage. We thanked our unnamed visitor for his expertise 
and kindness in providing this new lead.

I think GEO’s presence at the show was appreciated by the 
organiser because I have been asked to make a presentation 
about GEO’s activities, and amateur satellite reception in 
particular, at the next Kempton show, to which I have agreed. 
Please note the date in your diary: Sunday November 11, 
2012.

Finally, my thanks to David Simmons, who manned the 
stand with me and looked after the EUMETCast live reception.

The GEO stand at a quiet moment during a busy day. David 
Simmons can be seen talking to a visitor about our faulty USB lead.

running a show stand is a major commitment of time and 
effort by those involved.

On the technical side it was ‘fi rst’ for taking my new 
Technisat EUMETCast receiver to a show. This is a receiver 
I purchased in addition to the DVBWorld box that I have 
been using for several years and I’m pleased to report that 
it performed perfectly in its new temporary surroundings. A 
photograph showing the two receivers appears on page 3. 

However, we did suffer one technical glitch when, 
unaccountably, we experienced intermittent loss of the 
EUMETCast signal. A knowledgeable visitor to the stand 
suggested that there was a problem with our USB2 lead and 
kindly bought a replacement from a nearby stand. Once fi tted 

Cover and Full Page Images

Front Cover
This vision of Earth is a composite image created from data 
acquired during fifteen passes made by the Suomi-NPP satellite 
on May 26 this year. You can read more about this in the article 
‘View from the Top’ on page 34.

Image by Norman Kuring, NASA/GSFC/Suomi NPP

Inside Front Cover
David Taylor sent in this amazing NOAA-19 AVHRR image showing the 
UK and western Europe basking in hot sunshine on May 25, 2012, as 
an anticyclone kept cloud fronts at bay.

Image © EUMETSAT 2012

Inside Back Cover (upper image)
Top: An Envisat MERIS image dating from August 31, 2011 sent 
to us by Mike Stevens, showing the Canary Islands.

Image: ESA

Inside Back Cover (lower image)
This Meteosat-9 image from Mike Stevens highlights 
thunderstorms moving through central France towards England at 
13:00 UT on June 21.

Image © EUMETSAT 2012

Back Cover
On July 21, 2012, the Advanced Spaceborne Thermal Emission and 
Reflection Radiometer ( ASTER) on NASA’ s Terra satellite captured 
this image of an ice island, newly calved from Greenland’s Peterman 
glacier. You can read a report on this significant Arctic melting event on 
page 25 of this issue.

NASA Earth Observatory image by Jesse Allen and
Robert Simmon, using data from NASA/GSFC/METI/ERSDAC/JAROS

and the U.S./Japan ASTER Science Team.

Page 32
This is a composite from two Terra MODIS image segments 
acquired on May 22, 2010, showing a prominent algal bloom off 
southwest Ireland.

Image: NASA/GSFC, Rapid Response Team

Page 35
This Metop-A AVHRR channel-2 image acquired on June 1 this 
year shows the island of Greenland with a swarm of icebergs 
and brash ice streaming southwards along much of its eastern 
coastline. Also prominent are Iceland, with its icecaps sparkling in 
the sunshine, and, to its north, Jan Mayen Island.

Image: NOAA CLASS Archive
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Les Hamilton

Mark Drapes recently reported on the GEO-Subscribers forum that 
Metop-A images of the Antarctic on June 20 appeared to show a plume of 
steam venting from Mount Siple, a 3110 metre shield volcano just off the 
coast of Marie Byrd Land in Antarctica (73°26’ S, 126°40’ W). The volcano 
has a bulk similar to Mount Erebus, and has a summit caldera measuring 
4 × 5 kilometres. The mountain is named after Paul Siple (1908–68), an 
American explorer and geographer who visited Antarctica six times. The 
plume is also noted on the Volcano Discovery website at

http://www.volcanodiscovery.com/siple/news.html

The Metop-A image below, dating from 12:36 UT on June 20, provides an 
exceptionally fine view of the Antarctic peninsula. The plume described 
above is clearly visible as a comet-like artefact, near the foot of the 
image on its left hand side. Mark interpreted the image as indicating 
that the volcano was about -22°C, about 6° warmer that the surrounding 
landscape, while the base of the plume was at about -55°C. Images 
showing the plume in greater detail can be seen on page 16.

Aerial view of Mount Siple taken in 1958
Photo: US Navy/Wikimedia

Figure 4 - This channel-5 AVHRR image was acquired during the 12:26 UT Metop-A pass over Antarctica on June 20, 2012.
Image: NOAA Class Archive
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Francis Bell

Although I have reviewed ESA’s Bulletin before, the most recent 
issue, May 2012, deserves a special mention because it’s the 150th 
issue of this publication. Celebration of this milestone resulted in 
a special issue of the Bulletin, with 96 pages of reports and high 
quality colour photographs, some of which are in 3D, taken in 
space: a pair of glasses to view these photographs is included. The 
content of the Bulletin is worth reading from cover to cover. The 
celebration cover of the 150th Bulletin shows how the publication 
has evolved over the years.

There is a foreword by Jean-Jacques Dordain which gives a 
perspective on the rationale behind this regular publication which 
started in 1975.
‘The Bulletin is a window on the universe: it portrays ESA’s activities 
almost day by day and it exists because of the ESA specialists whose 
written contributions reach out to the international space community of 
decision-makers, industry, academics, students and the space-interested 
general public. As well as a wide range of in-depth articles on various 
disciplines, from space science to telecommunications, from satellite 
navigation to earth observation, from launchers to human space fl ight, 
from operations to technology, every issue provides an overview of ESA’s 
ongoing programmes and is a useful tool to keep abreast of the status of 
major space projects within ESA’.

I remind those who read this review that the ESA Bulletin is 
available free of charge if you apply to be included on the 
distribution mailing list. If you don’t action this point then that’s your 
loss.

To receive a regular copy, write to Distrimail, Postbus 122,
2370 AC Roelofarendsveen, The Netherlands, and ask to be put 
on their regular mailing list. Or email to info@distrimail.nl making a 
clear concise request to be placed on the ESA Bulletin mailing list: 
remember, this is a mailing company dealing with many customers, 
not just ESA, so be brief and specific with your request. Also give 
the reason for your request: perhaps a single word may cover your 
request: research, personal, education or other. This will enable 
ESA to know who is receiving their publication.

Figure 1 - Temperature profile of the Mount Siple plume Figure 2 - Metop channel-5 image of the Mount Siple plume

Figure 1 is an enlargement of the region surrounding the plume 
as revealed by the ‘temperature’ tab of David Taylor’s HRPT 
Reader software, which shows it, coloured blue, at around -50°C, 

significantly colder than its surroundings, which register in the 
range -25° to -30°. Figure 2 is the same scene, as revealed by the 
channel-5 sensor aboard Metop-A.
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Rob Denton demonstrated the versatility of the WXtoImg software 
when he created this HVC composite image on April 29, 2012.

Rob writes:
‘This image made using WXtoImg capturing only four northbound, 
daytime passes from NOAA-19. The program does everything 
automatically once you have decided which palette selection(s) you 
require. It’s amazing what can be obtained on simple equipment. I 
used just a Dartcom System II VHF receiver and a Wimo sloping 
crossed dipole antenna—with no added extras. Even though I’m 
now in a location further east than my previous home in Worksop, 
I have managed to image further west. The image was captured 
at my new home which is at the Windmill in North Leverton with 
Habblesthorpe, the longest village name in England. No wonder 
the locals simply call it ‘Leverton’. By the way, I’m living off-grid—no 

mains gas or electricity here: my power is produced by a generator 
and batteries. It’s such fun but a lot harder and more expensive 
having to buy diesel for the generator and bottled gas. I hope 
eventually to write an article describing my new life at Windmill 
Cottage. The windmill will be 200 years old next year, a cause for 
great celebrations. It’s still fully functional. 

‘This just shows that APT can be received anywhere.

‘This particular image captured the severe storms that caused flash 
flooding in much of the UK. Surprisingly, the rain didn’t seem to 
attenuate the signals on 137.100 MHz, allowing a clear image of 
what was happening despite the torrential downpours at the time. 
The local River Trent (2 km away), burst its banks, resulting in 
flooding to low-lying areas.’

Rob Denton G4YRZ
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Ron Hahn

As I mentioned in my previous article, there are a few prerequisites 
that are required for successful operation of a fully automatic 
weather station. A stable operating system, accurate time, a 
computer-controllable receiver, and a software suite capable 
of unattended operation. So, I have my Intel Atom PC, running 
Windows XP, NTP (network time protocol) provided by my local 
network, the excellent R2ZX receiver (available from the GEO 
shop) and WXtoImg software.

Although the freeware version of WXtoImg offers useful options, 
I recommend purchase of a license to unlock its full potential. 
There are two levels for this: Standard Edition at €47.95 and the 
Professional Edition at €69.95. Most of the basic features are the 
same between the latter two version but the Professional Edition 
includes extras like an on-image temperature scale, additional 
contrast and filter controls, selectable resampling algorithms and a 
commercial license. I have the Professional Edition and will focus 
on it for this article. The software is available from

http://www.wxtoimg.com/downloads

and the Windows package is approximately 8.5 MB in size. When 
you purchase the license, the author both emails and posts a paper 
copy of the license key. Also included in the envelope is a set of 
3D glasses for viewing the stereoscopic images, a nice touch.

To get the program up and running, you need to input your license 
key, and your receiving station’s latitude, longitude and altitude. 
The program only accepts decimal values for latitude and longitude 
so, if your GPS or other position source uses degrees, minutes, 
and seconds, you will have to convert these. I have found a useful 
on-line converter at

http://transition.fcc.gov/mb/audio/bickel/DDDMMSS-decimal.html

It is essential to have the correct position of the station or all 
position-based calculations, such as pass start and end times, will 
be incorrect. I used my Garmin GPS reading and converted it to 
decimal using the above link.

When the program is started, it first asks for the station location. In 
my situation, I entered my city (Rosslare Strand), country (Ireland), 
latitude (52.25), longitude (-6.23), and altitude (29 m) in their 
respective boxes, and pressed ‘OK’.

When this is completed, the program opens up a calibration 
dialogue explaining all the steps. First step: setting the ground 
station location (done in the previous paragraph). Second step: 
update the Keplers. This is easily done by going to the main 
WXtoImg menu and selecting File→Update Keplers. Third step: 
adjusting the volume. This requires patience because you have 

to be actually receiving a satellite signal to set this. The audio 
tones from the satellite are sent from the receiver to the computer 
soundcard as an audio signal, and must be at the correct level 
to be decoded properly by the software. Too little signal and 
the images lack contrast, too much signal and the soundcard is 
overloaded and the images are terrible. So setting the correct input 
level for the soundcard is exceptionally important. The WXtoImg 
page explains this exactly:

‘Set the volume control on the receiver to a low to moderate 
level, then select Mixer Control from the File menu. Configure the 
mixer to take input from the source the receiver is plugged into 
(normally the Line In). Set the Line level at about the mid-point. 
It’s better for the volume and line levels to be too low than too 
high to start with’.

Select Record from the File menu, and click on Auto Record.

Wait for a satellite to arrive. WXtoImg will indicate when the 
satellite is expected (in UTC) and on what frequency the satellite is 
transmitting in the status bar. WXtoImg will record the pass, during 
which an image should be shown. Do not be concerned with the 
brightness or darkness of the image, or other problems, such as it 
slanting across the screen. When setting the volume, never use this 
image as a guide—use only the volume setting discussed below. 
After recording is complete, WXtoImg will build a map and decode 
the image again to produce the best possible results.

Avoid using the scrollbars to scroll the image while a recording is 
taking place as this can cause the resulting image to be split.

The program volume (vol) will be displayed while the signal is being 
recorded. If a satellite is passing overhead, and the status line 
indicates that the program is still waiting for a signal, this can mean 
that the receiver volume is too low or that the mixer input level 
may be set too low. Slowly increase either or both until the status 
line indicates that the signal is being recorded. The volume on the 
receiver (or the recording level on the mixer) can then be easily 
adjusted during the pass to set a volume between 50.0 and 75.0. If 
the receiver has no volume control or the volume control does not 
affect the speaker output, then adjust the mixer settings (recording 
or input line level) until the displayed volume is between about 50.0 
and 75.0. The volume bar should be green when a signal is being 
received: red or yellow indicates the volume is too high or too low, 
as shown in figure 4.

At this stage it is important to check that the pass has sufficient 
signal. Signals from a satellite at low elevation will not fully ‘quiet’ 
the satellite receiver and produce a false volume input setting. I 
always listen to the pass during this process to ensure that no noise 
is present on the signal before I make any volume adjustment.

The image will be re-decoded after the satellite has passed, and 
when this is complete the overall volume will be shown on the right 
hand side of the status line below the image. The overall volume 
should be between about 40.0 and 85.0. Higher numeric values of 
volume (e.g. 90.2) indicate that the volume should be decreased, 
lower numeric values of vol (e.g. 24.7) indicate that the volume 
should be increased.

My current receiving station indicates a volume level of 79.5 on the 
most recent pass, which is well into the green category. If I set the 
volume too high, clipping occurs and detail is lost in the white areas 

In my last article [1], I gave an overview of the hardware and 
software required to successfully receive APT images. Here I will 
go more in-depth into the software setup, operations and some 
potential problems to be looking out for.

For the last several years, I have been using WxToImg as my 
automatic solution to receiving APT weather images. This software 
supports the fully automatic recording, decoding, editing, and 
viewing of received images. It offers so many options that the 
newcomer may be overwhelmed by the choices. It runs on all 
modern versions of Windows (XP, Vista, and Windows 7), as well 
as on Mac OSX and Linux. My installation runs on Windows XP, so 
I will be concentrating on the setup for that platform.
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of the image. If I set the volume too low, detail is lost throughout 
the image, which turns out dark. Except for this calibration, I found 
there is no need to adjust the volume when the satellite is passing 
overhead. Adjusting the volume during a pass produces bands in 
the final image and adversely affects the temperature calibration.

Once this calibration is completed I found that only some small 
adjustment was required on a subsequent pass. I have not touched 
it since.

Figure 5 on the following page shows a full screen shot of this 
reception in progress. As you can see, the reception is 52% through 
the NOAA 19 pass at this stage. Everything about the reception is 
shown on the display in real time: the date, time, satellite name, 
elevation, azimuth, volume level and pass start time, so that the 
operator can see exactly what is going on.

When the reception is finished, the program will store the data 
as an audio file on disk (as a WAV file in Windows) then start the 
automatic processing. This takes several minutes with an Atom 
CPU but a CPU with greater processing power will take less time. 
But the Atom works fine for me and has no CPU fan to fail from 
continuous operation. Once the processing is finished, the program 
waits for the next satellite pass to occur.

Further Processing
There are many, many processing and post-processing options in 
WXtoImg and I will now focus on some those that I use.

Under Options→Active APT Satellites, I have NOAA 19 ticked as priority 
No 1, NOAA 18 as priority No 2 and NOAA 15 ticked as priority 
No 3. I have unticked NOAA 17 because this satellite no longer 
produces images.

Under Options→Recording Options, I use the settings in figure 4.

Figure 1 - Satellite Volume Level

In figure 1, the input volume is set to 79,5, the received signal is 
low at this point in the pass, and the pass is 4% complete.

A problem that I discovered when I was first setting this up was 
images slanting across the screen. My current reception computer, 
based on an Asus Atom D525 (AT5NM10-I) motherboard, 
experienced this problem but my previous reception computer (an 
IBM Thinkpad T41) did not. So I had to perform a ‘slant correction’ 
to overcome this problem with the sound card.

Image Slant Correction
Start by selecting Disable PLL from the Options menu, which allows 
you to properly set the sampling rate. Next, select a recording to 
decode. Select Open Audio File from the File menu, and choose a 
recording, preferably one from a satellite making a high overhead 
pass for best results. Wait for the image to be decoded and 
displayed; it will appear bent slightly from top to bottom as a result 
of the Doppler shift, which is normal when the PLL is disabled.

Select Slant Correction... from the Image menu. Scroll to the top of the 
image and click on a vertical edge in the image. Continue holding 
the mouse button down and drag it down this edge, allowing the 
image to scroll, until you reach the bottom of the image, then 
release the button. A dialogue box will now pop up and display the 
suggested sampling rate. WXtoImg can estimate the sampling rates 
for all other satellites. Select the Estimate and Set sampling frequencies 
for all satellites option if it is not already selected, then click on 
Set. Deselect Disable PLL from the Options menu. The image will be 
decoded again and this time should be completely straight. If it is 
bent or jagged, ensure you have deselected Disable PLL. If it is still 
slanted, repeat the process, paying close attention to following the 
image margin down the screen.

While options are supposed to be saved on exit, I ensured that the 
sampling frequencies were saved by selecting Save Options from the 
Options menu. If the license key hasn’t been installed, now would be 
a good time to do that, before regular reception is started.

Now that the calibration and slant correction is complete the 
software is ready to start receiving pictures. Go to File→Record, and 
make sure Record and auto process is ticked. Once this is done press 
the Auto Record button and wait for the next pass, which will be 
indicated on the lower left hand corner of the screen (figure 2).

Figure 2 - Waiting for a Satellite

Remember that all times shown in WXtoImg are in UTC in order to 
avoid confusion about daylight time or time zones.

If all goes well, I will see the following change once reception of the 
satellite has commenced (figure 3).

Figure 3 - Waiting for a Satellite

Figure 4 - WXtoIMG Recording Options

In my setup, I have made several changes from the defaults. First, 
as my reception station is located on a peninsula with excellent 
exposure on both north-south and east-west directions, I have 
chosen to start recording when the satellite is at least 10° elevation 
(N/S) and 4° (E/W). I make use of the NOAA 2400 Hz carrier 
frequency, so do not depend on a guess to start recording. The 
common recording options are specific to my equipment, and the 
azimuth-elevation rotor control is not used. For example, your 
soundcard will show up as something else if you don’t have an IDT 
soundcard built into your receiving computer. If you are not getting 
any images when the satellite comes overhead then maybe you 
have not set the sound card properly. I have made this mistake.

Now is a good time to focus on the Options→Auto Processing Options. 
I found this section the most difficult to understand. So I go to 
Options→Auto Processing Options and tick Create image(s), then select 
the Image Settings button. I have the following Record Image Settings 
selected:
 • Normal
 • Pristine
 • Contrast enhance (NOAA ch A only)
 • Contrast enhance (NOAA ch B only)
 • MCIR map colour IR
 • MSA multispectral analysis MSA with precipitation
 • HVCT false colour
 • HVCT with precipitation NO colour IR enhancement
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Figure 5 - Recording a NOAA-19 pass

Figure 7 - Record Image Settings Pane

Enhancement Use

MSA Multispectral Analysis enhancement (used for daytime passes). The visible 
and IR channels are combined to produce a false-colour image.

MCIR Map Coloured IR enhancement (used for nighttime passes).

MSA-precip MultiSpectral Analysis enhancement with coloured estimated precipitation 
(used with daytime passes).

HVC False Colour, with or without precipitation.

HVCT
An enhanced false color image for daytime passes (with and without 
precipitation) SEA and SEA-Day - Sea temperature (day or night). With this 
enhancement, thin clouds will alter the imagery, giving artifi cial readings.

ANAGLYPH 3D presentation of clouds (like the 3D movies, you need 3D glasses to see 
this).

VEG Vegetation Index.

Table 1 - Some of the WXtoImg Enhancements

Figure 6 - The Webpage Options

Continued on page 30

The reader is reminded that not all of these 
options are available at all times: it depends 
on the specific satellite sensors in use during 
a pass. At night time, an enhancement that 
depends on the visible channel will not be 
available, for example. Figure 7 shows the 
panel where you select the images you wish to 
be processed.

The more enhancements you select, the longer 
it will take to complete the post-processing 
after an image is received and decoded. I find 
that it takes about 15 minutes to do all the 
post-processing of the image with my Atom 
CPU. As the post-processing is done you will 
see the processed images displayed on the 
screen as the work is completed. When it is all 
finished you can then go to the Saved Images tab 
on the menu bar to view them.

Image Processing
WXtoImg provides so many options for image 
processing that it is hard to know what will 
be the most pleasing to the eye. The ideal 
images, of course, would show where the 
cloud is, country outlines and maybe where 
the precipitation bearing clouds are. WXtoImg 
achieves all this automatically if it is set up to 
do so.

First of all, keep remembering that accurate 
time is very important for all of these things 
to come out properly. So, make sure that the 
Meinberg NTP software

http://www.meinberg.de/english/sw/ntp.htm

is installed and working properly. If the local 
PC clock is inaccurate, the country outlines 
will be displaced and this will cause a big 
headache later. David Taylor has done much 
good work about timekeeping in his web pages 
at

http://satsignal.eu/ntp/index.html

The WXtoImg site gives good examples of all 
the types of enhancements that the software 
can provide, at

http://wxtoimg.com/pics/

The main types of enhancements are listed in 
Table 1 opposite.

It is hard to find detailed information on these 
enhancements on the Internet but I have found 
that

http://tiete.be/jo/Noaa/NoaaLast.htm

has some of the best explanations, and some 
really good imagery too. In the end, I chose 
the enhancements that most appealed to me. 
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Zavodovski Island, just five miles wide, uninhabited and the 
northernmost of the volcanic South Sandwich Islands in the far South 
Atlantic, is one of the remotest places on the planet. Dominated by Mount 
Curry volcano, this tiny island can do compelling things to the sky around 
it, as this natural-colour MODIS image acquired from NASA’s Aqua 
satellite on April 27, 2012 shows: an interplay between low-level volcanic 
emissions, clouds, islands and winds.
 
Mount Curry is known to emit steady streams of gases and aerosols—
tiny solid and liquid particles. Aerosols are important in the formation 
of clouds, as they provide the nuclei around which water molecules 
accumulate to form droplets, and ultimately clouds. 
In the case of Zavodovski Island, sulphate aerosols from the simmering 
volcano seed clouds in the air masses passing over the island. Note 
how the plume stretching north is brighter than the surrounding clouds, 

a result of the small aerosol particle size and the numerous small water 
droplets that form around them. The smaller droplets provide more 
surfaces to reflect light.

To the southeast, Visokoi Island is also disturbing the atmosphere. It’s 
not clear whether gas and aerosols were being emitted from Hodson 
Volcano, or if the interesting cloud vortices are being created by 
topography. Like ships streaming through water, islands can create wakes 
in the cloud patterns above them. Visokoi rises to 1005 metres above 
sea level and, as prevailing sea winds push past, the jut of the island into 
those low-level marine clouds alters the flow of winds and air masses 
enough to affect their shape.

NASA image by Robert Simmon, based on data provided
by Jeff Schmaltz, LANCE MODIS Rapid Response

A NASA Earth Observatory Report
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Figure 2 - The Syr Darya on June 12, 2009, with no sign of the reservoir
Image: NASA/GSFC Rapid Response Team

Figure 3 - The Syr Darya on June 2, 2012, the reservoir now filled with water
Image: NASA/GSFC Rapid Response Team

Figure 1 -  A map showing the location of the Koksaray reservoir in
 relation to the Aral Sea, Syr Darya and Shardara reservoir.

Les Hamilton

In the June GEO Quarterly I included brief mention of 
the Koksaray Reservoir in the article: Syr Darya Control 
and Northern Aral Sea Project [1]. By the most amazing 
coincidence, just as your magazines were being distributed, 
Ukraine’s Sich-2 satellite transmitted the superb 8 metre per 
pixel image of the Koksaray Reservoir, reproduced opposite.

For years, there has been friction between Kazahstan and 
Kyrgyzstan over the latter nation’s use of water for hydro-
electricity generation. Over the years, Kyrgyzstan constructed 
numerous dams and reservoirs in the upper reaches of the 
Syr Darya river and its tributaries to store the water needed 
to operate their hydro-electric power stations.

January and February, the coldest months of winter, 
create the highest demand for electricity, and this is when 
the volume of water released from the reservoirs is at its 
maximum. The outpouring of this water is discarded back 
into the Syr Darya, signifi cantly increasing the river’s fl ow. A 
major consequence of this was annual fl ooding lower down 
the Syr Darya in southern Kazakhstan, where the terrain 
fl attens and the river meanders across an extensive fl ood 
plain between the Shardara reservoir and the Aral Sea.

The Shardara reservoir measures 70 × 20 kilometres, is 
6.5 metres deep and has a capacity of 5.5 cubic kilometres 
of water. It was constructed in 1966, in part to buffer the Syr 

Darya’s winter surges, but also to provide water for irrigation 
during the summer. It also includes a 100 MW hydro-electric 
plant to provide energy to Kazakhstan. But as Kyrgystan’s 
demands for electricity have mounted in recent times, the 
Shardarya reservoir has proved unable to adequately contain 
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the fl oodwaters, and Kazakhstan’s winter fl oods had become 
a chronic problem. Two factors conspired to create this 
scenario.

The main culprit was Kyrgystan’s Toktogul reservoir, at 
215 metres high by 292 metres long, the largest in central 
Asia (fi gure 6). It was built in the mid 1970s, backing up 
behind the dam as a lake 65 kilometres long and up to 120 
metres deep, capable of holding 18 km3 of water. As a result 
of the massive outfl ow of water from the Toktogul hydro-
electric station there have been fl oods along the lower Syr 
Darya every winter in recent decades. 

The second factor is the extremely shallow gradient of the 
Syr Darya below Shardara. Over the 1200 kilometre stretch 
of the river between the reservoir and the Aral Sea, the level 
drops through a mere 250 metres: from 291 metres above 
sea level where the Syr Darya leaves the Shardara reservoir 
to 46 metres a.s.l. when it reaches the North Aral Sea. That’s 
a mean drop of only twenty or so centimetres per kilometre. 
Little wonder then, that the Syr Darya fl ows sluggishly along 
a highly meandering course and that widespread annual 
fl ooding has been such an ever-present problem. The Sich-2 
image (fi gure 4) shows the looping meanders of the Syr Darya 
as it fl ows past the Koksaray reservoir.

Matters really came to a head in the spring of 2008 when 
the worst fl ooding since 1969 destroyed more than three 
million homes and cost Kazakhstan the equivalent of at 
least $US130 million. This disaster fi nally led Kazakhstan to 
embark on a major project to counter this fl ooding: and thus 
was conceived the plan to construct a new reservoir lower 
down the Syr Darya, just south of the village of Koksaray. 
This would hold excess water from the Shardara reservoir 
and protect a population of some 400,000 people who live on 
the river’s fl ood plain.

Koksaray Reservoir
The Koksaray reservoir was constructed in little over two 
years, commencing in 2008 as a high-priority project. 
During that time, 7500 workers built a 44.7 kilometre long 
retaining dam 7.7 metres high and 8 metres wide at its crest, 
to contain the water (fi gures 7, 8). The mammoth project 
utilised 5.5 million cubic metres of earth and 74 000 cubic 
metres of concrete capping. The speed at which the work was 
accomplished can be appreciated from the two Terra MODIS 
images opposite. Figure 2 dates from June 2009 when the 
project was less than a year old, and shows little sign of the 
reservoir, although there is evidence of construction work: 
specifi cally, what appear to be the retaining dam and the 
outfl ow channel that would eventually return water to the Syr 

Figure 4 - The Koksaray Reservoir, still well filled with winter floodwater, on June 2, 2012.
Image: Dniprokosmos (www.dniprokosmos.dp.ua)
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Darya. Figure 3, acquired on June 2 this year, clearly shows 
the new reservoir, now fi lled with water collected during the 
February/March fl oods.

Termed the Koksaray Counter Regulator—because it was 
conceived to counter excess fl ow from the Shardara reservoir 
and regulate the fl ow-rate of the river—the reservoir started 
storing water on a trial basis in February of 2010, even 
before work on it was complete. Over a billion cubic metres 
of fl oodwater (a cubic kilometre of water) were abstracted 
that spring. Construction was fi nally completed in December 
2011, allowing the storage up to three cubic kilometres of 
fl oodwater from the Syr Darya. This water is channelled 
into the reservoir along a fl ume 16 km long, capable of a 
fl ow-rate of 500 cubic meters per second. When the time 
comes to return water to the river, this is done via a 10.2 km 
canal, seen on the left of fi gure 4, also capable of delivering 
500 cubic metres of water per second [2].

The main aim of the Koksaray reservoir was to create a 
facility for storing excess winter runoff from the Syr Darya, 
and it fi rst came into full operation in early 2011, proving 
its worth by providing complete fl ood protection to scores 
of villages in southern Kazakhstan. For the fi rst time in ten 
years, residents of some 70 towns and villages along the fl ood 
plain from southern Kazakhstan to Kyzylorda experienced a 
spring without the fear of fl ooding to their homes and fi elds. 

Figure 5 - The first uptake of water passes through the
flood control dam of the Koksaray Reservoir in 2010

Photo: Tengri News

The high-resolution colour image (fi gure 4) shows the 
Koksaray Reservoir as was on June 2, 2012. The location 
of the reservoir is shown in the map on page 22, over a 
thousand kilometres up the Syr Darya from the Aral Sea and 
160 km north of the Shardara reservoir.

Irrigation
Of course, the Koksaray Counter Regulator was not designed 
solely to protect villages from fl oods. It was also devised to 
manage the region’s annual fl ood-drought cycle by providing 
water for crop irrigation during the summers. During the 
irrigation season, the contents of the Shardara reservoir had 
rarely been suffi cient to provide for the needs of the hundreds 
of hectares of cultivated fi elds in southern Kazakhstan and 
the region around Kyzlorda. Now, Koksaray can release 
additional water to help irrigate rice fi elds at Kyzylorda, as 
well as some 135 000 hectares on which to grow fruit and 
vegetables.

In tandem with the preexisting Shardara reservoir, a total 
of eight cubic kilometres of water can now be retained 
during winter and spring to augment the Syr Darya when its 
level drops during the summer. And of course, it is also an 
important part of the plan to refi ll the North Aral Sea.

Figure 6 - The Toktogul Dam in Kyrgystan
Image: Heinerbischkek / Wikimedia

Figure 8 - The Crest of the Koksaray Dam
Photo: Kazakhstan Ministry of Emergencies Press Service

Figure 7 - Construction of the Koksaray Dam in October 2010
Photo: Kazakhstan Ministry of Emergencies Press Service

In the past, Kazakhstan had to negotiate with its neighbours 
to release water for summer irrigation; now they have their 
own supply. And in the summer of 2011, the water released 
for irrigation from Koksaray was instrumental in ensuring a 
record rice harvest in the farmlands around Kyzylorda.

Continued on page 34



 September 2012 The Group for Earth Observation GEO Quarterly No 35

25www.geo-web.org.uk

The Petermann Glacier grinds and slides toward the sea along the 
northwestern coast of Greenland, terminating in a giant floating ice 
tongue. Like other glaciers that end at the ocean, the Petermannn 
periodically calves icebergs, and a massive ice island broke from it 
in August 2010. 

Now, nearly two years later, another large section of its floating 
ice tongue has calved into the Petermann Fiord, fracturing along a 
rift that was first identified in 2001, and which had been visible in 
satellite imagery for several years.

The Moderate Resolution Imaging Spectroradiometer (MODIS) on 
NASA’s Aqua satellite observed the calving at 10:25 UT on July 
16, 2012. At this point the iceberg was still close to the glacier, but 
by noon that day it had already started drifting northward down the 
fjord towards Nares Strait. The area of the original ice island was 
estimated to be approximately 130 km2, approximately half the size 
of the one that calved in 2010. Ice islands from this glacier drift 
southwards into Baffin Bay, and occasionally reach well down the 
Labrador coast, sometimes reaching Newfoundland, where they 
pose a hazard to shipping and navigation.

A NASA Earth Observatory Report

One day later, at 09:30 UT, Aqua spied a larger 
opening between the glacier and the iceberg, as well as some 
breakup of the thinner, downstream ice. The current iceberg broke 
from the glacier tongue farther upstream than in the 2010 event, as 
a result of which the Petermann Glacier has now retreated farther 
back the farthest yet recorded.

In the days that followed, the ice island started rotating and 
disintegrating, and when imaged by the Advanced Spaceborne 
Thermal Emission and Reflection Radiometer (ASTER) aboard 
NASA’s Terra satellite  on July 21, the iceberg had an area of 
32.3 km2. This image is reproduced on the back cover..

ASTER combines infrared, red, and green wavelengths of light 
to make false-colour images that help to distinguish between 
water and land. Water shows as blue, ice and snow vary in colour 
between pale blue and white, while land areas appear brown. 
Clouds in the scene cast dark shadows on to the iceberg surface. 

NASA Earth Observatory images on this page by Jesse Allen, using data from the Land 
Atmosphere Near real-time Capability for EOS (LANCE). Instrument:

Aqua MODIS images showing the ice island at image centre: left at 10:25 UT on July 12, centre at 12:00 UT on July 12 and right at 09:30 UT on July 13.



 GEO Quarterly No 35 The Group for Earth Observation September 2012

26 www.geo-web.org.uk

Ian Stotesbury (SSTL)

Surrey Satellite Technology Limited 
(SSTL) is the world’s leading small satellite 
company, delivering operational space 
missions for a range of applications 
including Earth observation, science 
and communications. The company 
designs, manufactures and operates 
high performance satellites and ground 
systems for a fraction of the price 
normally associated with space missions, 
with over 400 staff working on turnkey 
satellite platforms, space-proven satellite 
subsystems and optical instruments.

Since 1981 SSTL has built and launched 
36 satellites—as well as providing training 
and development programmes, consultancy 
services, and mission studies for ESA, 
NASA , international governments and 
commercial customers, with its innovative 
approach that is changing the economics of 
space.

NigeriaSat-2
(SSTL-300 platform)

Credit: SSTL

A Galileo FOC FM1 payload in the
SSTL clean room for final tests

Credit: SSTL

A 2.5-metre resolution image of Dubai Airport acquired by NigeriaSat-2
Image © National Space Research and Development Agency (NASRDA) of Nigeria - 2012

The SSTL satellite assenbly hall, pictured shortly 
after its opening in July 2011

Credit: SSTL

SSTL focuses on small satellites (from 
approximately 7 kg up to 600 kg) sold at a 
firm fixed price and with short production 
time, typically 18 to 24 months. SSTL has 
experience as mission prime for 30 satellite 
missions with a combined flight time of over 
200 years. The highest performance Earth 
Observation satellite for SSTL currently 
in orbit, NigeriaSat-2, has a resolution of 
2.5 metres and was launched in 2011 for 
NASRDA. By nature of a proven heritage 
evolution of products, the NigeriaSat-2 
design is being developed into SSTL’s 
next generation, state of the art, satellite 
design—a constellation of three satellites 
each capable of 1-metre, high-resolution 
imagery.

SSTL was also selected by ESA to supply 
22 navigation payloads for the deployment 
phase of the Galileo satellite navigation 
system. SSTL is teamed with OHB–System 
of Bremen, Germany, for the provision of 
these fully operational Galileo satellites. 
The two companies agreed to work together 
as a ‘core team’ on Galileo at the end of 
2007, with OHB taking the role of prime 
contractor and builder of the spacecraft 

‘bus’ and SSTL taking full responsibility for 
the navigation payloads aboard the satellite 
that will form the heart of the Galileo 
navigation system. Galileo is Europe’s own 
Global Navigation Satellite System (GNSS), 
providing real-time positioning, navigation 
and timing services with unrivalled accuracy 
and integrity. It will be interoperable with 
the American GPS system and Russia’s 
GLONASS system.
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NigeriaSat-2 captured this 2.5 metre resolution image of Salt Lake City Airport, USA in September 2011.
 Image: National Space Research and Development Agency (NASRDA) of Nigeria
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Impact craters can be tough to detect from the ground, especially 
when they are situated in remote locations and covered by 
vegetation. First identified in a German geological report in 1919, the 
Luizi Structure, hidden under grasses and vegetation more than a 
metre tall, remained unexplored for many decades. It was as recently 
as the 1990s that satellite imagery hinted that the structure might be 
a meteorite impact crater, and a week-long expedition to the Congo 
in June 2010 to collect rock samples for analysis finally provided the 
evidence to confirm this.

Microscopic analysis of the rock samples collected from the site 
revealed shocked quartz grains, strong evidence of meteorite 
impacts. The researchers studying Luizi reported the crater to 
measure about 17 kilometres in diameter, with an intermittent ring 
about 5.2 kilometers across and a smaller, central ring 2 km across. 
Around the perimeter of the crater rises a rim reaching 300 to 350 
metres above the interior: a typical, well-preserved, moderately sized, 
meteorite crater.

Exactly when Luizi formed is hard to answer. The researchers 
estimate nearby rocks to be 575 million years old, so the crater must 
be younger then this. The meteorite causing the crater must have 
measured close to a kilometre across, and been travelling at around 
seventy thousand kph.

A NASA Earth Observatory Report

The Advanced Land Imager (ALI) on NASA’s Earth Observing-1 (EO-1) satellite captured this natural-colour image of Luizi on June 2, 2012.
It is not perfectly round, but instead fills a semicircular basin where vegetation carpets the complicated topography.
NASA Earth Observatory image by Jesse Allen and Robert Simmon, using Advanced Land Imager data from the NASA EO-1 team.

A Landsat image of the Luizi Crater
Image: NASA
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Starting in July 2011, the tiny island of El Hierro in the Canaries 
experienced earthquake swarms that numbered in excess of 700 tremors 
by the end of the month. By late August, the total number of tremors had 
exceeded 4000. It was little surprise when, in late October, an underwater 
volcanic eruption was confirmed a mere kilometre south of the island’s 
southern tip.

El Hierro, the farthest south and smallest of the Canary Islands, sits on 
a tectonic hot spot in the Atlantic Ocean some 450 kilometres west from 
North Africa and Spain. The eruption is believed to be venting from a 
depth of some 200 meters below the sea surface, warming the water by 
as much as 10°C. Two months into the eruption, a significant mass of 
new crust had already built up but was yet nowhere near rising above the 
ocean surface and extending the Canary Island chain. Figure 2 shows 
milky green swirls of steaming lava fragments, heated gas, and other 
debris being carried to the west and north by currents. 

By February 2012, the underwater volcanic eruption was showing no 
sign of drawing to an end, and figure 3 shows the situation on February 
12. Bright aquamarine water indicates high concentrations of volcanic 
material and immediately above the vent, a patch of turbulent brown 
water indicates where the eruption is strongest.

Figure 1
The El Hierro volcanic plume on November 2, 2011

Figure 2
El Hierro and its offshore eruption on December 16, 2011.

Figure 3
El Hierro and its offshore eruption on February 2, 2012.

All images acquired by the Advanced Land Imager (ALI) aboard NASA’s Earth Observing-1 (EO-1) satellite
NASA images by Jesse Allen and Robert Simmon, using ALI data from the EO-1 Team 

A NASA Earth Observatory Report
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Living in Ireland, where it often rains, I place a special emphasis on 
the MSA-precip and HVCT-precip enhancements. So I encourage 
you to experiment with the different enhancements and decide 
which you like the best.

Website
These images are nice to look at on the local machine (or via 
Remote Desktop Protocol) but to really appreciate these things 
I like to have a web page that displays all the latest images. 
WXtoImg does this really excellently. Once I have made some 
small settings changes, the software automatically creates a web 
page with each new satellite pass and updates the web server.

To set up this option you need to use the Options→Auto Processing 
Options settings, with Add images to web page ticked. To set up these, 
click on the Web Page Settings button, where this dialogue appears in 
the second panel down in figure 6).

This is a simple pane to set up. Select the enhancements you wish 
to display on the web page—the name of the index file (HTML 
Filename box) and the ftp account details—and the program will 
automatically update the web page after every satellite pass. I tick 
the Exclude NOAA 17 option because this satellite is no longer able to 
transmit images, and would just waste space on the web page.

Things to Look Out For
Over the years I have seen several problems occur with my 
system, which affected the unattended reception of images.

Sometimes, WXtoImg raises an error and stops running. The usual 
sign of this is that the web images fail to update. Usually, this is 
an ‘out of memory’ error. Closing the dialogue box and restarting 
the program clears this and you can start receiving images 
again. Sometimes, reception continues uninterrupted for weeks, 
sometimes for only a few days. I have not determined the cause of 
these errors.

Very occasionally, the auto-ftp to my web server fails and I have to 
completely reboot the computer to clear this. The problem shows 
itself by failing to log into the ftp server. Everything looks good but 
it just won’t log in. Again, the result is a failure of my web page to 
update.

I have had a problem to do with the storage of images. When I 
started this automatic reception, I decided that a 20 GB drive for 
the system and a 480 GB drive for the data would be enough. 
But one day I noticed that my pages were not updating, and, after 

Despite these problems, I have found WXtoImg to be very stable. It 
receives the images, post-processes them, and uploads them to my 
web site at

http://www.ei2jp.org/wxtoimg/index.html

mostly without issues. I have been running WXtoImg for the past 
three years and am pleased at the results that it achieves.

Wrap Up and Work To Do
I received an email from Laurent Thomin, who has been creating 
wide-swath composite images of the Earth using images from 
many WXtoImg users, including myself. You can see the results of 
Laurent’s work at

http://www.thomin.com/wxtoimg/WCI.html

It was great to see that my images were being used as part of the 
curriculum of the Awty International School [2] in Houston, Texas.

Maybe you are thinking that I have nothing left to do with APT 
reception before the satellites turn off in some years time. But I still 
have a few things on my to-do list, such as getting my receiving 
aerial back up to full height, and experimenting with John Silver’s 
preamplifier [3], available from the GEO Shop.

I am not completely happy with the quality of my images and can 
still see some room for improvement. I think this is what makes the 
hobby both interesting and a challenge.

I am happy to answer questions about APT reception. You can 
email me at

ron.hahn@dhco.org

and maybe I can help you to get receiving too.

References
1 APT Weather Satellite Reception, GEOQ 32, page 34 (2011)
2 Awty International School - http://www.awty.org/
3 High Linearity LNA for APT - GEOQ 12, page 17 (2006)

Figure 8 - Setting the epiry time for old files

logging on, discovered that my data drive was full. I had not set 
any of the expiry options for my files and WXtoImg had completely 
filled up my hard drive. The lesson is to make use of the settings to 
expire old files (figure 8).

With the Remove images setting set to after 3 months my storage 
problem came under control and I have never again had this 
problem.

Continued from page 20

View from the Windmill

When Rob Denton returned to England from Bulgaria, he set 
up home in a windmill at North Leverton with Habblesthorpe, 
the village with the longest name in England. Judging by 
some of Rob’s satellite images, the location also boasts some 
of the best horizons for APT reception, as his NOAA-19 image 
showing Newfoundland proves.

The 15:30 UT NOAA-19 image from  March 24, 2012 featuring Newfoundland
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Jason Hopkins

Satellites have revolutionised the way we are able to 
visualise the Earth and in particular its oceans. Prior to 
the advent of satellite-derived data, oceanographic data 
could only be collected during research cruises. These 
datasets were usually confi ned to a relatively small area of 
ocean and represented a snapshot of the conditions at a 
discrete sampling site. Whilst in situ measurements remain 
an important part of marine science, satellites provide 
today’s oceanographers with the sort of temporal and 
spatial resolution that can reveal previously unseen ocean 
phenomena, such as the dynamics of algal blooms.

My work concerns the study of a particular type of 
alga (commonly referred to as phytoplankton) called a 
coccolithophore, specifi cally a species known as Emiliania 
huxleyi (fi gure 1). These are single celled algae, which are 
covered with an outer layer of intricately designed calcium 
carbonate (calcite) plates called coccoliths (fi gure 2). This 
particular species is approximately 5 – 10 μm in size 
(approximately one tenth the width of a human hair), so a 
scanning electron microscope is normally needed to observe 
individual cells in detail. 

result of a complex interplay of many different environmental 
factors, for example, light and nutrient availability, which 
may in turn be driven by other environmental variables. The 
process is further complicated by evidence that in certain 
parts of the world’s oceans, such as the Southern Ocean, 
even when there are suffi cient nutrients available that would 
normally promote growth, phytoplankton biomass remains 
relatively low. These are known as High Nutrient, Low 
Chlorophyll (HNLC) areas, and it is suspected that a lack of 
iron may responsible for the unexpectedly low growth rates. 
This hypothesis is supported by evidence that indicates 
that wind-blown dust from islands within these HNLC 
regions introduces iron to the surface ocean, which in turn 
encourages phytoplankton to bloom in these normally barren 
areas.

Towards the end of the bloom stage, E. huxleyi starts to 
produce multiple layers of coccoliths, which are subsequently 
shed into the water column. These tiny coccoliths (~ 2 μm 
across) act like mirrors, refl ecting a large proportion of the 
incident light back out of the ocean, turning the ocean a 
milky turquoise colour and resulting in patches of high 
refl ectance that can be observed by ocean colour sensors 
such as the MODerate resolution Imaging Spectrometer 
(MODIS) sensor onboard NASA’s Terra and Aqua satellites. 

Although these ‘white waters’ had previously been observed 
during research cruises, the extent of their coverage could 
not be fully determined without satellites. The earliest 
indications of these high refl ectance patches in satellite 
imagery came from coastal Landsat imagery. It was theorised 
that these were probably phytoplankton, as they appeared to 
follow the course of an oceanic front. However, it wasn’t until 
1983, when Professor Patrick Holligan (then at the Marine 
Biological Association, Plymouth) set out to investigate these 
patches that it was confi rmed that they were indeed caused 
by coccolithophores. He found that these ‘blooms’ could 
extend over an area of up to 250,000 km2 (approximately the 
same area as the UK), making the coccolithophore a major 
infl uence on the biogeochemical carbon cycle. Figure 3, 
opposite, is a true-colour Terra MODIS image dating from 
May 22, 2010, showing a coccolithophore bloom off the 
southwest coast of Ireland (Image: NASA/GSFC, Rapid 
Response Team).

Traditionally, variations in satellite derived ocean colour that 
have been converted to estimates of chlorophyll concentration 
(the green photosynthetic pigment found in plants) have 
been used to monitor long-term, global variations in 
phytoplankton populations. However, these data alone do 
not enable us to clearly distinguish coccolithophores from 
other phytoplankton that contribute to the chlorophyll 
signal. The bloom seen in fi gure 3 is not obvious in the 
8-day chlorophyll composite for the area from the same 
time period (fi gure 4), probably due to the relatively low 
chlorophyll content of coccolithophores. Fortunately, 
because the calcite containing coccoliths affect backscattered 
refl ectance, oceanographers can utilise this property to 
investigate coccolithophore distributions, via the application 
of a mathematical algorithm that converts the change in 
backscattered refl ectance caused by the coccoliths into an 
estimate of Particulate Inorganic Carbon (PIC). Thereafter 

Figure 1
A single coccolithophore

 Image courtesy of Chris 
Daniels, NOC

Figure 2
Shed liths from a coccolithophore
Image courtesy of Chris Daniels, NOC

Phytoplankton are tiny plant cells that are poorly understood, 
but are vitally important to life on Earth as they produce 
half of all the oxygen in the atmosphere (land-based plants 
produce the rest). Phytoplankton extract carbon dioxide from 
the seawater, which is in equilibrium with the atmosphere, 
and convert it to organic carbon and oxygen in a process 
known as photosynthesis. The coccolithophore also extracts 
carbon—in the form of carbonate—from the water column 
to form its calcite coccoliths. The shed coccoliths have the 
potential to sink out of the surface ocean into the deep 
ocean and, over geological time periods, these can become 
compressed into sedimentary layers, sequestering the carbon. 
A prime example of this process is the White Cliffs of Dover. 
But how do satellites play a part in our understanding of this 
microscopic organism?

Like any photosynthetic organism, coccolithophores require 
sunlight and so need to occupy the upper few tens of metres 
of the water column. When conditions are optimal, their 
growth rate increases and they form blooms, similar to the 
greening of terrestrial vegetation in spring. 

Several mechanisms have been proposed as possible 
catalysts for blooms. It is likely that bloom initiation is the 
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it can be assumed that any variation in the location and 
magnitude of the PIC signal corresponds to similar changes 
in the underlying coccolithophore population. Figure 5 shows 
the PIC composite product for the same time period as the 
chlorophyll signature in fi gure 4. In this case the structure of 
the bloom is more evident. The NASA Ocean Colour website 
(http://oceancolor.gsfc.nasa.gov/) provides a wealth of freely 
available data products of parameters, derived from various 
algorithms, that affect ocean colour. These data are available 
at different levels of processing. The Level 3 products used in 
my study are geolocated, spatially and temporally composited 
data obtained from several overpasses that can be easily 
processed in analytical packages such as Matlab or WinBilko 
to provide insights into the dynamics of this biogeochemically 
important phytoplankton. 

Whilst E. huxleyi is typically found in all areas of the global 
oceans, it seems to produce its largest blooms in discrete 
oceanographic regions. These blooms have a high degree of 
both temporal and spatial variability associated with them, 

the causes of which remain undetermined. But why is this 
important? The use of satellites to identify areas where 
coccolithophores bloom on a regular basis allows scientists 
to not only understand the underlying drivers that may 
favour growth, but also to monitor any long term variation 
in this species: for example, in response to climate change. 
This is crucial, as changes in coccolithophore populations 
may result in the loss of a carbon sink and disruption to the 
complex oceanic food webs. In addition, the application of 
our present day knowledge to the distribution of the fossilised 
remains of coccolithophores found in sediment cores can help 
provide a window on the oceans’ responses to past changes 
in climate. It is only with the use of satellite data that we are 
able to monitor the long-term, global trends of this important 
phytoplankton, which will hopefully provide scientists with 
more pieces to fi t into the climate change puzzle.

Jason Hopkins is a PhD student at the
National Oceanography Centre, Southampton

Figure 4
MODIS 8-day composite chlorophyll data from May 17-24, 2010. Note that the 
feature shown in figure 3 is not clearly defined in the chlorophyll product alone.

 (Data processed using WinBilko v3.3)

Figure 5
MODIS 8-day composite Particulate Inorganic Carbon data

from May 17-24, 2010 showing coccolithophore bloom.
 (Data processed using WinBilko v3.3)

This fascinating Envisat segment shows the island of Crete, enhanced by sunglint and sea surface rippling on January 30, 2012
Image submitted by Mike Stevens - © ESA
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Other benefi ts are anticipated, such as introducing fi sh into 
the reservoir with a view to establishing a seasonal, commercial 
fi sh catch, and making use of the reservoir basin for growing 
forage crops for harvesting and grazing once the waters have 
dispersed.

Aydar Lake
A glance at the map (fi gure 1) immediately reveals that there 
is another body of water in the region, Adyar Lake (Aidarkul), 
which is considerably larger than the Shardara and Koksaray 
reservoirs combined. Therein lies an interesting tale.

At fi rst sight this would appear to be yet another reservoir but 
that is not the case. When the Shardara Dam was built in the 
early sixties to create its eponymous reservoir, Aydar Lake did 
not exist. All that was present was a dried out salt basin located 
in the Arnasay lowland, a natural depression in the Kyzylkum 
desert. In the spring, a small lake sometimes appeared there for 
a short period, but dried up completely by the summer.

In 1969 there occurred one of the most serious fl oods ever on 
the Syr Darya, so much so that the Shardara reservoir was in 
danger of overfl owing. Between February 1969 and February 
1970, the gateways controlling the water level behind the dam 
had to be opened to protect the structure, and some 21 km3 of 
runoff from the Syr Darya drained into the Arnasay lowland, 
unintentionally creating the Aydar Lake. In the years since, this 
lake has regularly been fed by excess fl oodwater from the Syr 
Darya when it exceeded the capacity of the Shardara Reservoir. 
Over the years, the natural cavity of the Arnasay lowland has 
fi lled up to create the second largest lake in the region (after the 
remnant Aral Sea). Unfortunately, as it lies at a lower elevation 
than the Syr Darya, there is no easy way of returning the waters 
of Aydar Lake to the river during periods of drought.

Today, Aydar Lake is 250 km long by 15 km wide, has a surface 
area of 3000 km2 and contains 44.3 cubic km of water. Though 
slightly brackish, Aydar is basically a freshwater lake, averaging 
only two grams per litre of salts. Many species of fi sh such as 
pike, perch, bream and catfi sh have been introduced into the 
lake, which nowadays supports a fi shing industry providing 
catches up to 2000 tonnes annually. In addition, many species 
of water birds, migrating from the Aral Sea, make their homes 
around the lake.

2012 ... and the Floods Return
Against all expectations, fl ooding returned to the lower 
Syr Darya valley in 2012 following a particularly high river 
fl ow during the fi rst three months of the year. Because of a 
particularly severe winter, the Syr Darya had frozen completely 
along the length of its fl ood plain between Shardara and 
Kyzlorda. The ‘normal’ excess fl ow from upstream power 
stations was augmented when rain and mild conditions in the 
mountains produced unexpected mass melting of snow. With 
the Syr Darya frozen, this water could not be channelled away, 
and fl ooding returned to southern Kazakhstan.

Hundreds of homes were damaged, roads were washed out and 
fi elds and pastures fl ooded. More than two thousand people 
were evacuated to schools, hospitals and mosques. Both the 
Shardara and Koksaray reservoirs were fi lled to capacity and 
able to accommodate only around half the excess fl ow of the 
Syr Darya. Although this was recognised to have been a unique 
event, unlikely to be repeated, it does now raise the question as 
to whether a further reservoir may have to be constructed lower 
down the river, in the Oguzsayskoy depression near Mayakum.

References
1 Syr Darya Control and Northern Aral Sea Project
 GEOQ 34, page 10 (June 2012).
2 gazeta.kz - http://engnews.gazeta.kz/art.asp?aid=356072

There have been many images of the full disc of Earth 
from space—a view often referred to as the Blue Marble—
but few have looked quite like the version on the front 
cover of this issue. Using natural-colour images from the 
Visible/Infrared Imaging Radiometer Suite (VIIRS) on the 
recently launched Suomi-NPP satellite, a NASA scientist 
has compiled a new view showing the Arctic and high 
latitudes.

Ocean scientist Norman Kuring of NASA’s Goddard Space 
Flight Center pieced together this composite image of 
Europe, Asia, North Africa and the entire Arctic. It was 
compiled from fi fteen satellite passes made by Suomi-NPP 
on May 26 this year. The spacecraft circles the Earth from 
pole to pole at an altitude of 824 kilometres and multiple 
passes are needed to gather suffi cient swaths of data to 
display the entire hemisphere without gaps in the view.

Kuring stitched the image swaths together then set up 
this view, looking down from 70°N, 60°E. This is, of 
course, an artifi cial view, as the satellite cannot image the 
full Earth disc at one time. Kuring was able to show the 
Arctic in this image because northern hemisphere spring 
spreads enough sunlight over the North Pole to allow a 
360° natural-light view. 

VIIRS is a scanning radiometer that acquires data in 
22 spectral bands which cover visible, near-infrared, 
and thermal infrared regions of the electromagnetic 
spectrum. It was designed to extend and improve upon 
the measurements of land masses, oceans, ice and the 
atmosphere made over the past two decades by the 
Advanced Very High Resolution Radiometer (AVHRR) 
and the Moderate Resolution Imaging Spectroradiometer 
(MODIS).

Image by Norman Kuring, NASA/GSFC/Suomi NPP

A NASA Earth Observatory Report

Launch Date for Metop-B Agreed

Following a lengthy wrangle, Russia and Kazakhstan have 
at last come to an agreement over the Metop-B launch from 
Baikonur, originally May 23, and which is now slated to take 
place on September 19, 2012.

Erratum
In the circuit diagram for Guy Martin’s digital thermometer 
project, the inputs and outputs on the voltage regulators are 
transposed. For In read Out, and vice versa.

Continued from page 24

Koksaray Reservoir

City Lights on Google Maps
Fred van den Bosch contacted us with details of a new Google 
Maps service. Many readers will be familiar with the ‘City Lights’ 
imagery acquired by NOAA’s DMSP satellites.

There is now a new Google Maps overlay, which, in addition 
to the normal ‘Map’ and ‘Satellite’ views, also offers a ‘Night’ 
option. You can now zoom into any location on Earth and view 
the planet by the lights of its cities at

http://www.blue-marble.de/nightlights/2010
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David Taylor, GM8ARV

I had been looking for a way to record a few weather 
parameters on a casual basis for some time and had already 
found indoor and outdoor temperature probes available on 
the Internet; I later discovered an indoor temperature and 
humidity probe. However, pressure seemed to elude the 
Chinese makers of these probes so, late last year, I bought 
a wireless weather station—which would have been ideal 
were the software up to the same standard as the hardware. 
Unfortunately though, while the indoor display panel worked 
most of the time, it was so unreliable when interrogated by 
software that I sent the unit back for a refund. During my 
Internet explorations I discovered a low-cost pressure sensor, 
which was an add-on hardware to an Arduino compatible 
computer. The discovery was the JeeNode from JeeLabs.

http://jeelabs.com/products/jeenode

Seeing Guy Martin’s recent article made me realise that this 
alternative approach might be of interest to GEO readers, as 
only a very few non-surface-mount components are required, 
and the programming model is the widely supported Arduino.

http://www.arduino.cc/
The JeeNode
JeeLabs offer a variety of formats of hardware, all designed 
for ‘physical computing’ (i.e. real-world measurements) 
and the hardware is designed to be very easy to connect 
together. The main computing part is designed around 
Arduino compatibility, so there’s plenty of software available, 

and there is an extensive library of software to support the 
hardware boards you can add to a JeeNode. I wanted to drive 
this from a PC, so I chose a JeeNode with a USB port, but 
there is quite an interest in battery-powered JeeNodes which 
can be interrogated remotely with an 868 MHz RF signal.

The JeeNode can be programmed with the standard Arduino 
development environment, which is well described and well 
supported. There is forum here where you can get help.

http://arduino.cc/en/Guide/Environment

The development environment communicates with the 
JeeNode via a USB lead with a serial COM port emulation. 
Once your program (in Arduino nomenclature, your sketch) is 
running on the JeeNode, the same COM port is available for 
the PC to communicate with the JeeNode.

Hardware
For this project, I chose a JeeNode with a USB interface and 
a Pressure Plug, a small board for their atmospheric pressure 
sensor, which is based on a BMP085 chip.

http://jeelabs.net/projects/hardware/wiki/JeeNode_USB

http://jeelabs.net/projects/hardware/wiki/Pressure_Plug

You can get various multi-pin connectors to solder to the 
board to adapt the confi guration to best suit your own 
needs—I used just a single 6-pin header so that I could 

Figure 1 - General view of the JeeNode Barometer.

Figure 2 - An elevation view, showing how the Pressure Plus is mounted above the main JeeNode USB board.
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unplug the pressure sensor if required. You 
can buy these boards ready-made (as I did), 
and there are some kit options if you have 
surface-mount facilities (which I do not).

Software
Getting data from the JeeNode
There is sample code provided to drive 
the BMP085 in a JeeNode confi guration, 
and all I had to do was to provide serial 
access to that data. Most of the listing, 
in Appendix 1, is simply copied from the 
sample provided. As this is both my fi rst 
Arduino and fi rst JeeNode program, I could 
probably have done things in a much better 
way. The function I wanted was to be able 
to send a serial character to the board and 
get back the pressure data. Line 32 in the 
execution loop waits until a character is 
received on the serial line. Any character 
will do to elicit a response. Lines 36-45 get 
the current pressure (and temperature) 
reading, and calibrate it into the expected 
values. Lines 48-56 send the values back 
to the serial port, including a prefi x of the 
characters ‘BMP’ and a carriage return 
suffi x so that you could read the data a line 
at a time.

Using the Data
As regular readers may recall, I am a fan of 
MRTG for simple graphing of data over both 
short and long intervals, so I wrote a small 
program which interrogates the JeeNode 
and returns data in a suitable form for 
MRTG. Please contact me if you wish a 
copy of this program.

You could easily write a program in 
Visual Basic, or your favourite language, 
to interrogate the data by sending one 
character to the COM port, and reading the 
response.

An alternative, should you wish a stand-
alone unit such as Guy Martin described 
in GEO Quarterly 34, would be to add 
a compatible graphics board from the 
JeeLabs shop and program it appropriately.

http://jeelabs.com/products/graphics-board

The Photos
Figure 1 shows a general view of the 
JeeNode Barometer, looking directly down 
on the board. The USB connector is on the 
right and the (unused) RF interface on the 
left. The pink wire is the antenna for the RF 
interface. The Pressure Plug is the square 
board left of centre, and you can just see 
a few of the pins from the surface-mount 
processor to the right of it. The chip right of 
centre is the FTDI serial-to-USB chip. There 
are red and green LEDs which fl ash when 
serial data is sent or received.

Figure 2 is an elevation view of the board, 
and illustrates how the Pressure Plug is 
mounted above the main JeeNode USB 
board. The black item is a multi-way socket 
allowing the Pressure Plug to be removed 
and different hardware substituted.

Appendix 1 - Code Listing
(0 ) // Ports demo, reads out a BMP085 sensor connected via I2C
(1 ) // 2009-02-17 <jc@wippler.nl> http://opensource.org/licenses/mit-license.php
(2 ) 
(3 ) // 2010-05-22: added support for all resolution modes
(4 ) // 2010-05-25: extended to also broadcast all readings over wireless
(5 ) // 2010-06-17: add power saving logic, should reduce consumption by over 90%
(6 ) // 2010-06-24: improved power savings, several “hot spots” optimized
(7 ) 
(8 ) // see http://news.jeelabs.org/2010/06/20/battery-savings-for-the-pressure-plug/
(9 ) // see http://news.jeelabs.org/2010/06/30/going-for-gold-with-the-bmp085/
(10) 
(11) #include <JeeLib.h>
(12) #include <PortsBMP085.h>
(13) 
(14) PortI2C two (4);
(15) BMP085 psensor (two, 3); // ultra high resolution
(16) 
(17) // This power-saving code was shamelessly stolen from the rooms.pde sketch,
(18) // see http://code.jeelabs.org/viewvc/svn/jeelabs/trunk/jeemon/sketches/rooms/
(19) 
(20) void setup() {
(21)  Serial.begin(57600);
(22)  Serial.print(“\n[bmp085demo]”);
(23)  
(24)  psensor.getCalibData();
(25) }
(26) 
(27) void loop() {
(28)  // sensor readout takes some time, so go into power down while waiting
(29)  // int32_t traw = psensor.measure(BMP085::TEMP);
(30)  // int32_t praw = psensor.measure(BMP085::PRES);
(31)  
(32) if (Serial.available()) 
(33)  
(34) {
(35)  char ch = Serial.read();
(36)  psensor.startMeas(BMP085::TEMP);
(37)  delay(16);
(38)  int32_t traw = psensor.getResult(BMP085::TEMP);
(39) 
(40)  psensor.startMeas(BMP085::PRES);
(41)  delay(32);
(42)  int32_t praw = psensor.getResult(BMP085::PRES);
(43)  
(44)  struct { int16_t temp; int32_t pres; } payload;
(45)  psensor.calculate(payload.temp, payload.pres);
(46)  
(47)  // this code is not needed for use as remote node, keep it for debugging
(48)  Serial.print(“BMP “);
(49)  Serial.print(traw);
(50)  Serial.print(‘ ‘);
(51)  Serial.print(praw); 
(52)  Serial.print(‘ ‘);
(53)  Serial.print(payload.temp);
(54)  Serial.print(‘ ‘);
(55)  Serial.print(payload.pres);
(56)  Serial.print(“\n”);
(57)  
(58) }
(59) delay (300);
(60) }
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Esko Petäjä

In Finland, the most typical effect of bad weather (storm, wind, 
snow or lightning) is that we lose electrical power. In cities, 
the electrical network is based on underground cables but in 
countryside we use overhead wires which are often carried on 
pylons through narrow breaks in forests. In winter, heavy snowfall 
often topples trees on to the power lines, and then we lose 
electrical power. During last Christmas, after several storms, there 
were wide areas where people were without electricity for two to 
three weeks. When storms hit a wide 
area, electricity supply companies 
are not able to fix errors in short time. 
When there is a lot snow, repairs will be 
harder and time consuming. 

Today, when regular land line 
telephones are not used so much, 
we are highly depended on wireless 
communications. Last Christmas, storm 
Dagmar caused such widespread loss 
of electricity (and for such a long time) 
that many GSM cellphone base stations 
were put out of commission. There was 
a widespread loss of communications 
and even governmental offices such 
as the police and fire services were 
unable to operate fully. The photograph 
below shows how trees are cut back to 
prevent them falling on to power lines.

Storm Dagmar (December 24-25, 2011)
Starting on Christmas Day, Dagmar moved from northern Scotland 
to western Norway, unleashing winds as intense as many 
hurricanes. Winds at Sella Ness, Shetland, in the north of Scotland, 
produced gusts of up to 162 kph. Still more powerful winds were 
clocked on oil rigs west of Norway, where they were about as 
strong as those of a Category 3 hurricane (over 178 kph). Figure 2 
shows the storm reaching the west coast of Norway.

Figure 1
 A Helicopter trims trees near 

a power line
Image © Fortum

Figure 2 - Storm Dagmar approaching Norway
Image © EUMETSAT 2011

When Dagmar reached Scandinavia, many roads where closed and 
over 100 000 people in Norway and 200 000 in northern Sweden 
lost power; in some places broadcast radio went off the air although 
most still had phone and cellphone coverage. The Home Guard 
(reserve military) were called out to assist with damage assessment 
and power line inspection.

The worst communications emergency happened in the municipality 
of Vågsøy, where they were completely lost. Emergency services 
were organised in the city hall, where inhabitants were asked to 
report if they needed help. The only communication method was 
by the satellite phone of a line fishing boat, MS Frøyanes, which 
provided a lifeline to the outside world. Some ‘Simplex’ handsets 
were used to communicate with care homes. The governor of 
Sogn og Fjordane county asked the military to establish HF 
radio links. Amateur radio emergency communications were also 
activated.

Figure 3 - Dagmar hits small village on the west coast of Norway

Figure 4 - A local radio amateur helping with emergency communications
Image © NRRL

The storm reached Finland on Christmas Day morning and winds 
were strongest throughout the morning and early afternoon. On 
the southwest and the west coasts, the wind blew at more than 
80 kph, felling trees, which caused the power outages. In the Baltic 
Sea winds were storm force, and severe storm force in the Gulf of 
Bothnia. 

We have been reading from newspapers and seeing in TV how weather disasters have been hitting different areas. Indeed, the very cold 
conditions in Europe, when many people froze to death, were featured in the previous two issues of this magazine. In Finland and the 
other Nordic countries we are use to the cold and snow, and it is very seldom that such conditions cause deaths. The main problems 
resulting from severe cold are damage to infrastructure and transportation. Below I describe how storm ‘Dagmar’ hit the Nordic countries 
and Finland and how amateurs have helped in the field of emergency communications
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Sea level probably increased to dangerously high levels in lowland 
coastal areas. The rain came mostly as rain or sleet, but snow in 
the north of the land. Wind gusts increased throughout the country 
during the evening causing loss of electrical power across large 
areas. 

In the USA. Radio amateurs undertake a lot of emergency 
communications work: specifically, during the North America 
blackout (2003), Hurricane Katrina (2005). The same was true in 
China in the wake of the 2008 Sichuan earthquake. The goal of 
Radio amateurs is to create a voluntary secondary communication 
system which can be used when other methods are failing, 
thus helping authorities to do their duties. These activities are 
coordinated by GAREC (Global Amateur Radio Emergency 
Communications) [2].

Hurricane Katrina (September 2005)
Hurricane Katrina was the deadliest and most destructive hurricane 
of the 2005 Atlantic Hurricane Season. It was the costliest natural 
disaster, as well as one of the five deadliest hurricanes, in the 
history of the United States. Katrina caused at least 1,836 deaths, 
some in the actual hurricane, others as a result of the subsequent 
floods. In total, property damage was estimated at $81 billion. 
During this hurricane, 1000 amateur radio volunteers served in 
the stricken area to provide communications for agencies such as 
the American Red Cross and The Salvation Army, and to facilitate 
interoperability between agencies. 

Electrical lines downed by Dagmar

Most of the longest power outages occurred near the city Salo 
(where Nokia was established). The Salo region suffered power 
outages for ten days and the GSM networks were down for three 
days. This raised concerns in the city’s social service authorities 
about elderly people living alone. Without means of communication, 
they could not be contacted and, also, they had no way to call for 
help in the event of an emergency. For this reason, the authorities 
asked radio amateurs to patrol elderly peoples’ homes to check 
that everything was OK, which they did throughout the three days. 
A local high-power 2-metre repeater with a range of 50 kilometres 
(OH1RAD) was used for communications and high power (50 watt) 
mobile stations were used in cars. 

Preparation for Total Disaster
Because wide scale power outages are not uncommon in Finland, 
there is held, every second year, an exercise for emergency 
communication organised by amateurs. This year’s exercise topic 
simulated a major breakdown in the main National Power Grid. 
This topic was very well adapted to the effects of storm Dagmar 
and the communications exercise was organised by dividing 
Finland into security areas, in each of which communication was 
effected by VHF radios to the area HQ. From this area HQ, further 
communications with the national HQ was done using by HFLINK [1] 
communication. 

Emergency Communication through Amateurs
Even the professional communications equipment used by the 
Authorities can sometimes fail during a total disaster. Amateur 
systems, by contrast, are not as dependent on terrestrial facilities 
that can fail; also, they are dispersed throughout communities, and 
they do not have ‘choke points’ that can become overloaded, like 
cellphone base stations.

Location and coverage of the 2-m repeater OH1RAD
used during the emergency

 The principle of communication during the national power outage exercise

Some of the Montgomery, Alabama Radio Amateur Team in their 
communications centre while helping in the aftermath of Hurricane Katrina

Image © ARRL
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Kobe Earthquake (Japan 1995)
On January 17, 1995, at 05:46 local time, a magnitude 7.3 
earthquake hit the densely populated surrounding the city of Kobe. 
The centre of Kobe was heavily damaged, with 6434 fatalities and 
43,782 injured. Over half a million homes were damaged, and a 
hundred thousand destroyed. Over 300 000 citizens had to be 
evacuated.

In response to an administrative request, JARL (the Japanese 
Amateur Radio League) started its Emergency Communication 
effort later the same day. They were specially authorised to handle 
amateur communications relating to road and traffic conditions, 
safety and location of residents, names of shops able to provide 
water and food, and the availability of Public Services.

Emergency Communications used by Authorities
Authorities such as energy companies and fi re brigades use TETRA 
(Terrestrial Trunked Radio) radio in their communications and there are 
many nationwide TETRA radio network. TETRA supports both speech 
and data transmission, the latter in both packet and circuit switched 
modes. In Europe, TETRA uses the 380-400 MHz and 410-430 MHz 
bands.
A TETRA network call can be established very quickly (0.3 seconds) 
and provides two-way calls between units. TETRA can also support calls 
involving multiple users.

TETRA radios, as used by Authorities
Image: © Fortum

Conclusion 
Although we have very high-tech infrastructure with all our 
sophisticated communication devices like 3G/4G, these rapidly 
become useless following a major power outage. Area infrastructure 
is very vulnerable. From case studies, it is clear that VHF 
communication provided by amateurs has been very helpful in 
conditions of severe weather and natural disaster.

References

1 HFLINK - http://hflink.com/
2 GAREC - http://www.iaru.org/garecnet/

This substantial new publication from EUMETSAT covers the 
past 25 years of their history. A substantial hard-back book with 
320 high quality A4 sized pages, this is a comprehensive record of 
EUMETSAT’s history and its achievements. It weighs 1.7 kg. The 
text is divided equally between English and French: generally, even 
numbered pages are in English and odd numbered ones in French, 
and the photographs, tables and diagrams carrying notes in both 
languages. 

A Preface to the book states:
The success story of satellite meteorology in Europe is closely linked to 
two organisations. One is EUMETSAT itself which, in just two decades, 
has become one of the world’s pre-eminent meteorological and 
environmental satellite organisations, serving the interests of Europe’s 
National Meteorological Services, the citizens of Europe and way 
beyond. The other is the European Space Agency (ESA).
ESA research expertise was required for the conception and 
development of the fi rst Meteosat back in the 1970s, and ESA was 
also the driving force behind the original formation of EUMETSAT. 
Over the past 25 years the relationship between the two organisations 
has evolved, and ESA has now become an established and important 
cooperation partner and procurement agency for EUMETSAT.

A Book Review by Francis Bell

Book details
ISBN 978-92-9110-091-0: Printed in 2011: Published by 
EUMETSAT, Eumetsat-Allee 1, 64295 Darmstadt, Germany.

I have just ten copies of this book for distribution to GEO members. 
The book itself is free of charge but packing and postage will cost 
£8.00 or €10.00. If you would like a copy sent to you, please email, 
telephone or write to me and I will let you know if I still have stock.

You can download this book in PDF format (21 MB) from
http://www.eumetsat.int/groups/cps/

documents/document/pdf_br_history-book.pdf

Although the book is well illustrated and contains some satellite 
images together with tables, charts and diagrams, it is not a book 
devoted to ‘wow’ factor satellite images, but follows the history and 
important events leading up to EUMETSAT’s 25 year anniversary in 
2011.

The first two chapters recount the early activities of Europe 
in the field of meteorological satellites and the setting up of 
EUMETSAT. Chapter three deals with the expansion of national 
memberships and cooperative agreements intended to lead on 
to full membership. Chapters four and five record the story of 
geostationary and polar-orbiting satellites, chapter six tells the story 
of EUMETSAT’s foray into the world of ocean altimetry with the 
Jason programme, while chapter seven deals with EUMETSAT’s 
ground segment composition. Chapters eight and nine record 
international cooperation and involvement with assistance given to 
developing countries. Chapter ten examines the role of research 
and training and helping users exploit EUMETSAT’s products. 
Finally, chapter eleven sums up the history and provides additional 
information about the internal workings of the organisation. 
There are five annexes. I found Annex 2, which covers important 
milestones in the evolution of EUMETSAT, particularly interesting 
because of its concise nature.

I would judge this book to be a ‘must have’ for anyone seriously 
interested in weather satellites and particularly EUMETCast 
reception. I received my book as a complimentary copy from 
EUMETSAT and I offer my thanks to them for this beautiful and 
informative publication.

Weather, Disasters and Emergency 
Communication

Continuied from page 39

A sample 
page from 
the book, 

illustrating its 
format
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High-pressure weather systems 
often bring fair weather and 
relatively clear skies. In early 
June 2012, an anticyclone off 
the coast of Tasmania did just 
this in spectacular fashion.

This MODIS image at right, 
from NASA’s Aqua satellite, 
displays a spectacular weather 
system over the Great 
Australian Bight at 05:00 UT 
on June 5, 2012. The high 
pressure region appears as 
a 1000 kilometre wide oval 
hole in the blanket of marine 
stratocumulus clouds.

The cloud hole results from 
sinking air associated with the 
anticyclone. Compared with 
the average sea-level pressure 
of around 1013 millibars, the 
pressure at the centre of this 
high exceeded 1040 millibars.

The 06:00 UT sea-level 
pressure map published by 
the Australian Bureau of 
Meteorology on the same day 
shows the shape of the cloud 
hole to match the shape of the 
high-pressure area. However, 
the respective centres of high 
pressure and the cloud hole 
didn’t match precisely. The 
centre of the anticyclone was 
located near the western edge 
of the cloud free zone, some 
100 kilometres from the cloud 
edge.

A NASA Earth Observatory Report

This MODIS image acquired by NASA’s Aqua satellite at 05:00 UT
on June 5, 2012 shows a high pressure system south of Australia. 

Image: NASA/GSFC Rapid Response Team

The 06:00 UT sea-level pressure 
map showing the Anticyclone
Credit: the Australian Bureau of 

Meteorology

In general, winds blow outward 
and away from areas of high 
pressure, as a result of which 
areas of high pressure pull air 
downwards. As the air sinks, it 
also warms, increasing the rate 
of evaporation of cloud droplets, 
thus making it difficult for the air 
to sustain clouds. Areas of low 
pressure, by contrast, pull air 
upwards, generating clouds and 
stormy weather.

http://earthdata.nasa.gov/data/near-real-time-data/rapid-response
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Dear Les,
I quite felt for you when you questioned 
in the current editorial the efficacy of 
committing 100 plus hours to produce the 
GEO Quarterly to a shrinking audience. 
Couple this to a lack of articles to fill the 
pages and I feel I would be asking similar 
questions.

The life of our particular hobby can be 
likened to a generation game: the first 
generation that used mechanical devices 
coupled to electronics to get an image; the 
second generation who built frame stores 
and the third generation using a purely PC 
based system.

I have worked my way through each sector 
of the generation game and, even though 
I still marvel at the quality and reasonably 
reliable method of obtaining images, 
nothing will ever match the excitement of 
developing a sheet of bromide fresh off the 
facsimile machine on a Sunday evening. 
The ergonomics of owning such a beast as 
a Muirhead K300, coupled to shift working, 
meant I was fortunate to get one image a 
week.

Keeping up with developments in the 
weather satellite field as it grew meant 
there was no shortage of articles in the 
magazines of the day. Constant fine-tuning 
of all components and reacting to the 
latest published ‘tweek’ or circuit kept one 
very busy. With the reliability of today’s 
products, once you are up and running the 
world is your visual oyster and little else 
needs to be touched (OK, I know that’s a 
silly thing to say as all my systems will now 
stop).

I feel that the unsaid role of the Quarterly is 
to keep members abreast of developments 
with the service providers. Our hobby is 
totally different from the ‘pay for’ services 
offered to industry, military and others. 
We do not provide them with funds other 
than our taxation allotment via our current 
government. Down all the years, with very 
few exceptions, all the providers have 
treated the amateur weather satellite 
enthusiasts with equanimity.

The Quarterly’s role is very important and 
I hope it will continue. It could become 
three times a year rather than disappear. 
I would not wish you to feel downhearted 
at what is achieved in the Quarterly as it is 
superbly published with some of the finest 
images I have ever set eyes on. Other 
professional publications in the field suffer 
a dearth of constructive articles and pad 
their pages with far less worthy items than 
our publication does.

The magic of being able to provide an up 
to the minute image has never left me, and 
no young person I have shown an image 
to has failed to be enthralled by it. As 
amateurs that’s something we do well.

Please continue, as you and the GEO 
Quarterly I am sure, are most appreciated 
by all in the field, and who knows what 
impact it may have on the scientists of the 
future.

Peter Stien

Hello Les,
GEO Q34 arrived a while ago, and I was 
as always happy to receive it. I really 
liked the article about the Aral Sea. It is 
interesting to note the different ambitions 
between Kazakhstan and Uzbekistan when 
it comes to restoring the sea.

I became a bit sad when I read the editorial 
with your question ‘Is there any demand 
for GEO to produce an expensive glossy 
magazine.’ For me, here in Sweden, 
where I feel somewhat alone with my 
hobby, it is incredibly valuable to receive 
the magazine. It gives me a touch of what 
happens. And even if I am only receiving 
APT, I learn about the possibilities that 
EUMETCast and other things give. 
And also articles on meteorological and 
environmental matters are very pleasing.

About the ‘glossiness’ of the magazine, 
I could well do with lower ambitions. But 
I am one of those people who still like to 
have a physical paper in hand.

The other question, about how to boost 
membership is really difficult. I recognise 
the problem from several DX clubs in 
Sweden, but I can’t say that any of them 
have arrived at a good solution. Radio 
amateur clubs seem to be somewhat 
luckier in their recruitment. I believe that 
you already have got many proposals to 
work via Internet, and this may be a way, 
but there I believe others can come with 
better ideas than I.

Best regards, Anders Höök, Sweden

Les,
Let me first thank you for the excellent 
copies of GEO Quarterly that have arrived 
at my door, and for assisting me in laying 
out my articles and pictures. I’m very 
pleased with the end results.

What concerns me is the news that a lot of 
people who where members of GEO have 
decided not to rejoin the group. This is sad 
news indeed, and something that needs to 
be addressed urgently.

Every Group consists of its members: 
without them there is no Group, and it is 
sad indeed that more members are not 
contributing to the Quarterly to help keep 
the interest and the Group alive. I realise 
we do not have any new satellites going 
into orbit yet, and we lost Envisat just when 
it was getting interesting, but that is life—
you get ups and downs but you still carry 
on regardless.

The Group Management needs to address 
the loss of members as an urgent issue. 
GEO needs to advertise more openly in 
different Electronic and Radio Magazines. 
Going to shows is fine but that needs to 
change by attending more in different 
regions—not the same shows as last year. 
If there is not the budget for this then that 
should be looked at also. And if there are 
problems with obtaining material for the 
Quarterly, then perhaps reduce the print to 
three issues per year and use the money 
saved to advertise the Group.

To survive in this extreme financial climate 
we have to take bold steps. Perhaps it is 
time the membership was asked for its 
thoughts on the future of GEO. Let’s give 
up on complacency and lack of initiative 
and look to the progressive future of 
GEO, before we have too few members to 
sustain us.

Keep up the good work Les. We need 
people like you.
Kind Regards, Mike Stevens (G4CFZ)

Dear Editor,
A big Thank You from my side to all who 
contributed to the GEO Quarterly 34. I 
received my copy today (July 12), thanks 
to the special efforts of David Anderson 
and Francis Bell. Because of my mild 
disorganisation and carelessness I had 
unwillingly postponed my annual fee 
payment too long, but that’s now solved 
and sorted out. The ‘Thank You’ extends 
also specially to the authors and everyone 
else who contributed time and work 
towards the Quarterly: also, I assume to 
several very understanding and patient 
spouses, if I can extrapolate from my 
own environment. Cheers, Ulrich Kliegis, 
Germany.
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GEO held its Annual Meeting at SSTL following the tour of the 
facility (see page 6), when all present were provided with a pack 
containing the agenda, balance sheets and reports from the 
membership secretary and editor.

Director’s Report
Francis Bell opened by briefly recounting the rationale for GEO’s 
company status and liability, then voiced his worries about GEO’s 
declining membership. He wondered whether we were missing out 
on means of attracting new blood to the group, as new members 
were not coming forward as he would like. He also touched upon 
GEO Quarterly, and whether the balance of articles directed 
towards beginners and experts was right. Interestingly, Arne 
van Belle, representing the Dutch organisation De Kunstmaan, 
reported that they faced similar problems to GEO, with an ageing 
membership and few new young newcomers joining.

This problem was discussed and, in particular, how GEO might 
attract new members. There was a suggestion from the floor that 
GEO needed to raise its profile through increased publicity both in 
the UK and abroad.

Membership Report
David Anderson informed that overseas membership had fallen 
by 38, although USA members had been increasing for several 
years. It was suggested that the latter might be as a result of 
Ed Murashie’s articles in the Quarterly and posts on the GEO-
Subscribers Internet forum.

A considerable number of new members stay with GEO for only a 
single year, probably to obtain advantageous prices on equipment. 
And of course, they can, thereafter obtain the support they require 
from the GEO Subscribers Internet forum.

There was a suggestion from the floor that an automatic renewal 
system for membership subscriptions might help the situation, 
avoiding the loss of members by default. It was agreed that the 
Director and Membership Secretary would look into this.

GEO Accounts
Based on last year’s figures, GEO is only just breaking even. 
Costs continue to rise, and an increase in subscriptions may be 
needed. There was some discussion about the merit of a two-tier 
membership: full membership, with the printed Quarterly and a 
reduced price membership to receive a downloadable version. But 
there were problems with this, most notable of ensuring security: 
preventing copying and sharing by non-members. Also discussed 
were the possibility of engaging a cheaper printing firm and 
consulting the membership on their preferences.

GEO Shop
Francis Bell proposed a vote of thanks to Carol and Clive Finnis 
for running the GEO Shop, along with David Simmons. It continues 
to be a success and adds considerably to GEO’s funds. Carol and 
Clive have given notice that they wish to retire from running the 
Shop at the end of this year so, with David Simmons continuing 
in his support role, GEO now needs someone to take care of the 
stock holding, ordering, despatch and financial operations.

Editor’s Report
Les Hamilton reported that, after some initial doubts over resuming 
as editor, things had gone really well in compiling the December 
Quarterly. Article submissions from members had arrived regularly 
making the task relatively straightforward. Alas, this momentum 

had not been maintained into the New Year, and he was faced with 
sourcing/producing a large proportion of the content in both the 
March and June issues himself. It’s a worrying and disappointing 
trend that so few readers seem willing to support the Quarterly by 
making contributions these days.

Other Matters
Over the years, GEO has been pleased to welcome several 
members of Werkgroep Kunstmanen to our Symposiums, when 
they have set up interesting displays. It would be a nice touch if 
GEO could reciprocate in kind. The Dutch Group are holding a 
meeting in Utrecht on Saturday, September 8 this year, and David 
Taylor and Les Hamilton have already made plans to attend. 
Perhaps some other GEO members would like to join them in the 
Netherlands.

Everyone voiced thanks to Alan Banks for his efforts in creating the 
new-look GEO website, and for his continuing efforts in updating it.

Time restrictions at SSTL truncated the meeting, but discussions 
continued over an evening meal when a number of action points 
were agreed: to request a quote from our printers regarding a 
shorter print run for the Quarterly; contacting a sample of members 
to establish their views about the Quarterly in electronic format; 
progressing the devolvement of shop responsibilities from Clive 
and Caron Finnis to a willing member; promoting the advertising of 
GEO Shop on the web site; to maintain four annual issues of the 
Quarterly even if shortage of copy meant fewer pages.

Summarised from minutes compiled by John Tellick
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A layer of stratocumulus 
cloud over the Pacific 
Ocean served as the 
backdrop for this rainbow-
like optical phenomenon 
known as a glory. Glories, 
which form when water 
droplets within clouds 
scatter sunlight back 
toward the source of 
illumination, often appear 
as concentric rings of 
colour in mist or fog. 
Although glories may 
resemble rainbows, they 
are formed differently. 
Whereas rainbows are 
formed by refraction 
and reflection, glories 
are formed by backward 
diffraction. The most 
vivid glories form when 
an observer looks down 
on thin clouds containing 
droplets between 10 and 
30 microns in diameter. 
The brightest and most 
colourful glories also form 
when droplets are roughly 
the same size. 

This this MODIS image 
captured by NASA’s Aqua 
satellite on June 20, 2012 
shows a glory over the 
Pacific Ocean. In this 
case the, glory does not 
appear circular because 
MODIS scans the Earth’s 
surface in narrow swaths 
perpendicular to the path 
of the satellite: the swaths 
show horizontal cross 
sections through the 
rings of the glory, which 
thus takes the form of 
two elongated bands of 
colour.

Another notable feature in 
this image is the stream 
of swirling von Karman 
vortices to the right of 
the glory. The alternating 
double row of vortices 
form in the wake of an 
obstacle, in this instance 
the eastern Pacific island 
of Guadalupe.

NASA image courtesy Jeff 
Schmaltz, LANCE MODIS Rapid 

Response

A NASA Earth Observatory Report
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For several months each year, Russia’s 
Lake Baikal is covered by a thick 
layer of ice. Formation begins in late 
December, and by mid-January the 
entire lake is usually blanketed. Come 
spring, the lake begins its long, slow 
melt. Patches of open water usually 
appear in the southern part in early May 
and move progressively northward, but 
it’s usually late June before the last 
remnants of ice disappear from Baikal’s 
northern reaches.

This Moderate Resolution Imaging 
Spectroradiometer (MODIS) image 
from NASA’s Aqua satellite shows ice 
breaking up in the central part of the 
lake in early May. Ice cover remains 
solid in the north but drifting ice and 
large patches of open water are visible 
throughout the southern part. The image 
also shows ‘fast ice’ along the coasts—
this is ice that is anchored to the shore 
and does not move with winds or 
currents. It usually persists longer than 
ice that forms over deeper water.

A monitoring station at Listvyanka, about 
70 kilometres southeast of Irkutsk on 
the southeastern coast of Lake Baikal 
has kept uninterrupted records of ice 
formation and melting dating back to 
1869. These reveal some interesting 
trends related to the timing of ice break-
up, most notably that it is occurring 
earlier nowadays than in the past. 
In the 1870s, thawing began around 
May 10; now it often begins in late April. 
In general terms, the onset of the thaw 
has advanced by half a day per decade 
between 1869 and 1999.

Events at Listvyanka don’t necessarily 
apply to Lake Baikal as a whole, 
however. Satellite data acquired 
between 1992 and 2004 by NASA’s 
Jason-1 and Europe’s Envisat showed 
that, over the central and northern parts 
of the lake, ice had been forming later, 
but also breaking up later and lasting 
longer overall. For the southern part of 
Lake Baikal, the satellite data showed 
that although ice was again forming later 
in the winter, the timing of the spring 
breakup remained fairly constant.

The reasons for the changes are still 
being debated. Air temperatures play 
a leading role in how long ice persists, 
and recent decades have seen Siberian 
winters become colder in response to 
the Arctic Oscillation. Other factors that 
can affect how long Baikal’s ice lasts, 
include wind patterns, lake currents, 
clouds, snowfall, and the volume of river 
water discharged into the lake.

A NASA Earth Observatory Report

This image was acquired on May 4, 2012, by the MODIS instrument aboard NASA’s Aqua satellite
NASA image by Jeff Schmaltz, LANCE/EOSDIS MODIS Rapid Response
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EUMETCast On-Line 
Registration Guide

If you require to register as a first-time user for 
any of the free EUMETCast data streams such 
as MSG, NOAA AVHRR, Metop etc., or need 
to renew an existing subscription, this must be 
done on-line.
GEO has produced a step-by-step guide to the 
entire process at

http://www.geo-web.org.uk/eumreg.html
This guide also contains a direct link to the 
official EUMETCast on-line registration form, 
which can otherwise prove somewhat tricky to 
locate.

GEO Helplines
Douglas Deans
Dunblane, Perthshire, SCOTLAND.
All aspects of weather satellites from APT, 
HRPT to Meteosat-9 DVB/EUMETCast 
systems.
 • telephone:(01786) 82 28 28
 • e-mail: dsdeans@tiscali.co.uk

John Tellick
Surbiton, Surrey, ENGLAND.
Meteosat-9 advice: registering for the various 
MSG services, hardware and software 
installation and troubleshooting. John will 
also field general queries about any aspect of 
receiving weather satellite transmissions.
 • telephone: (0208) 390 3315
 • e-mail: info@geo-web.org.uk

Geoff Morris GW3ATZ
Shotton, Flintshire, NE WALES.
Geoff has lots of experience with aerial, 
coax,connectors, mounting hardware etc. and 
has also done a lot of work with the orbiting 
satellites. Geoff has been a EUMETCast 
Meteosat-9 user for some time and is familiar 
with David Taylor’s MSG software. He 
should be able to share his experiences with 
newcomers to this branch of the hobby.
 • Tel: (01244) 818252
 • e-mail: gw3atz@btopenworld.com

Mike Stevens
Portland, Dorset, England.
Advice and assistance offered on EUMETCast 
(MSG and Metop) and Envi-Ham (including 
ESA’s Visat software for decoding the images).
 • email: mike1g4cfz@msn.com

Guy Martin G8NFU
Biggin Hill NW Kent, ENGLAND
Guy is prepared to advise anyone who wishing 
to receive MSG/Metop using Windows 2000 or 
XP. Can also help with networking and ADSL 
router setup.
 • gmartin@electroweb.co.uk

Hector Cintron
San Juan, Puerto Rico, USA
Hector is prepared to field enquiries on HRPT, 
APT, EMWIN and NOAAPORT
 • Phone: 787-774-8657
 • e-mail: n1tkk@hwic.net

Email contact can of course be made at any 
time, but we would ask you to respect privacy 
by restricting telephone contact to the period 
7.00-9.00 pm in the evenings.

Internet Discussion Groups
There are a numerous Internet-based 
discussion groups available to weather satellite 
enthusiasts. You can join any of these by 
sending an e-mail to the appropriate address, 
with a request to subscribe. Indeed, a blank 
e-mail containing the word ‘subscribe’ in its 
Subject line is all that is required. Some of the 
more useful groups and their contact addresses 
are listed below.

APT Decoder
This is a group where users of Patrik Tast’s 
APTDecoder can share information and 
problems.

http://tech.groups.yahoo.com/
group/APTDecoder/

GEO-Subscribers
This is GEO’s own group, where members can 
exchange information and post queries relating 
to any aspect related to weather satellite 
reception (hardware, software, antennas etc), 
Earth observation satellites and any GEO-
related matter.

http://tech.groups.yahoo.com/
group/GEO-Subscribers/

Satsignal
An end-user self help group for users of 
David Taylor’s Satellite Software Tools 
(SatSignal, WXtrack, GeoSatSignal, HRPT 
Reader, GroundMap, MSG Data Manager, 
AVHRR?Manager and the ATOVS?Reader).

http://tech.groups.yahoo.com/
group/SatSignal/

MSG-1
A forum dedicated to Meteosat Second 
Generation (MSG), where members share 
information about the EUMETCast reception 
hardware and software.

http://tech.groups.yahoo.com/
group/MSG-1/

The Editor is always delighted to receive 
articles and images for inclusion in 
GEO Quarterly. These can relate to any 
aspect of Earth Imaging, especially
• Technical articles concerning relevant 

hardware and software
• Construction projects 
• Weather satellite images
• Reports on weather phenomena
• Descriptions of readers’ satellite imaging 

stations
• Activities from overseas readers
• Letters to the Editor
• Problems and Queries for our experts to 

answer
Contributions should of course be original 
and, where possible, should be submitted 
to the editor in electronic format (e-mail 
attachment, CD, DVD). But of course, we 
would also accept handwritten or typed copy.
Please note, however, that major articles 
which contain large numbers of satellite 
images, photographs or other illustrations 
should be submitted as early as possible, 
so that they can be prepared and made up 
into pages in time for publication.

Images and Diagrams
Images can be accepted in any of the major 
bitmap formats: JPG, BMP, GIF, TIFF etc. 
Images in both monochrome and colour are 
welcomed. Line drawings and diagrams are 
preferred in WMF, EPS or postscript formats. 
We can also scan original photographs, 
negatives and slides.

Gridding, Overlays and Captions
Please note that readers’ satellite images 
should be provided without added grid lines, 
country outlines or captions unless these are 
considered essential for illustrative purposes 
within an article.
If your article submission contains embedded 
images and diagrams, please note that you 
must also submit copies of the original 
images in one of the formats described 
above: these are essential for page make-up 
purposes.

Submission of Copy
Materials for publication should be sent to 
the editor,
 Les Hamilton
 8 Deeside Place
 Aberdeen AB15 7PW
 Scotland

The most efficient way to do this is by email 
attachments to the following address

geoeditor@geo-web.org.uk
Particularly large attachments (8 MB and 
above) can be transmitted via YouSendIt

www.yousendit.com
_________________________

And finally . . .
if you do have material ready for the next 
issue of GEO Quarterly, please submit it 
as soon as it is ready—do not wait till the 
deadline above: this will simply create an 
editorial log-jam and delay publication.

Copy Deadline for
GEO Quarterly No 36 is

Sunday, November 4

Weather Satellite Reports

If there is a single Internet Forum that is 
relevant to all weather satellite enthusiasts, 
it must surely be Douglas Deans’ Weather 
Satellite reports.

Here you will find every conceivable type of 
information about weather satellites, whether 
polar or geostationary, APT, HRPT, LRIT or 
whatever.

Absolutely everything is covered, and the 
information is updated every week. Special 
additional bulletins may be issued if an 
important change takes place mid week. 

You can read the bulletins from this URL

http://tech.groups.yahoo.com/group/
weather-satellite-reports/

or, even better, elect to have the reports sent 
to you by email every Monday.
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Mike Stevens sent us this terrific Envisat MERIS image dating from August 31, 2011, featuring the Canary Islands and part of western Africa.
Image: ESA

Mike Stevens captured a cluster of highly active thunderstorms tracking through central France towards England
in this high-resolution Meteosat-9 image, received via EUMETCast at 13:00 UT on June 21, 2012.

Image © EUMETSAT 2012




